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About This Guide

This user’s guide follows the NCD ThinSTAR Operating Software 
and NCD ThinPATH Manager Installation Guide. It describes NCD’s 
thin client computing and explains how to set up individual 
NCD ThinSTAR desktops.

If your site plans to implement centralized configuration through the 
optional NCD ThinPATH Manager product, use the NCD ThinPATH 
Manager Centralized Startup Guide instead.

Audience
This guide is for users or system administrators who:

� set up individual NCD ThinSTAR desktops 

� configure NCD ThinSTAR terminals

� manage terminal connections including Microsoft Terminal 
Server (RDP) connections, Citrix ICA connections, and Internet 
Explorer browser connections.

Organization
This guide is organized as follows:

� About This Guide
Describes the contents of this guide.

� Setting Up NCD ThinSTAR Desktops
Describes NCD’s thin client computing and explains how to set 
up individual NCD ThinSTAR desktops.

� Configuring Terminal Properties
Introduces and describes the terminal properties, tab by tab.

� Managing a Terminal’s Connections
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Documentation

Provides reference information for managing a terminals 
connections, including Microsoft Terminal Server (RDP) 
connections and Citrix ICA connections.

� Navigation Paths and Special Key Sequences
Summarizes movement between tools and the use of special key 
sequences.

Documentation
Documentation is available online in PDF format or on the NCD 
website at:

www.ncd.com 

For most online documents, select: Start\Programs\Administrative 
Tools (Common) and then: 

� NCD ThinSTAR OS\Online Documentation for:

or

� NCD ThinPATH Manager\Online Documentation for:

Installation Guide Software installation for NCD ThinSTAR 
Operating Software and NCD ThinPATH 
Manager.

Terminal User’s Guide Information on individual terminal setup; 
description of terminal properties; and 
information on creating and managing 
connections.

Terminal Administration Guide Automatic updating and recovery of NCD 
ThinSTAR terminals with the ThinSTAR 
Operating Software, troubleshooting and a 
glossary.

User’s Guide Description of the setup wizard with brief 
introduction to terminal properties and 
connections.

Release Notes Release-specific details and last-minute 
information.

Centralized Startup Guide Terminal setup from a central location, 
configuring terminal properties and 
connections for groups of terminals.
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Documentation

Manager Reference Information about NCD ThinPATH Manager 
tools with a section on troubleshooting and a 
glossary.

Release Notes Release-specific details and last-minute 
information.



4 NCD ThinSTAR Terminal User’s Guide

Documentation



NCD ThinSTAR Terminal User’s Guide 5

Setting Up NCD ThinSTAR Desktops

The following sections describe NCD’s thin client computing and 
explains how to set up individual NCD ThinSTAR desktops.

If your site plans to implement centralized configuration through the 
optional NCD ThinPATH Manager product, use the NCD ThinPATH 
Manager Centralized Startup Guide instead.

NCD Thin Client Computing
With the NCD ThinSTAR product, users at NCD ThinSTAR 
terminals run Windows applications on servers with Microsoft 
Windows 2000 with Terminal Services, Microsoft Windows NT 4.0, 
Terminal Server Edition, the Citrix MetaFrame software for Terminal 
Server, or the Citrix WinFrame operating system. Additional NCD 
products extend access to UNIX hosts and to other hosts through 
terminal emulation.

Users do not run applications stored on their local terminals; they 
see application screens on their desktops, but the applications are 
running on servers.

When you first start a terminal, you complete a setup wizard to set 
terminal properties and create an initial connection. Later, you can 

Windows Terminal Server

Many applications run
on the server.

User files are stored in
the server's file system.

Multiple users connect
to the server.

Users see applications
screens.

NCD ThinSTAR

PC
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change terminal properties with Terminal Properties software and 
you can add connections.

Introduction to Terminal Setup
Terminal setup involves going from terminal to terminal and 
completing the following processes:

� Completing initial terminal setup

� Creating connections

� Configuring terminal properties

Once you complete these steps, the user can connect to a Windows 
Terminal Server and run applications that are on the server.

In preparation for setting up terminals, you may want to print the 
NCD ThinSTAR Terminal Administrator’s Guide, which is in PDF 
form. This document is on the product CD and is installed online. To 
reach the online documents, select Start\Programs\Administrative 
Tools (Common), then select NCD  ThinPATH Manager\OnLine 
Documentation or NCD ThinSTAR OS\OnLine Documentation. You 
can also locate the documentation on the NCD website at:

www.ncd.com 

Completing Initial Terminal Setup
This section explains how to do initial terminal setup, which 
includes starting an NCD ThinSTAR terminal and completing setup 
wizards for the terminal and for printing. For information on 
configuring terminal properties, see Configuring Terminal 
Properties on page 25.

To start terminals and complete the setup wizards:

1. Start the terminal.

2. Click Next when the Welcome appears.
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3. Click Accept at the License Agreement to acknowledge 
acceptance of the legal terms governing product use.

4. Select the network connection type, then click Next.

The terminal can connect to a server through the LAN or by 
dialing in over a modem.

5. Select a default client, then click Next.

The default can be the Microsoft Terminal Server client or the 
Citrix ICA client. The NCD dial-up client is not a protocol client. 
It creates a network connection via modem for protocol clients.

6. Enable or disable dynamic assignment of IP addresses, then click 
Next. For dial-up clients, IP addresses are not requested; go to 
Step 9 on page 9.

Choose an addressing option:

— Yes, use the IP information supplied by DHCP.

A network with DHCP can provide the IP address. A 
terminal gets its address and other network identifiers 
through the DHCP service by default if it is properly 
connected to the network and DHCP service is available and 
configured. Go to Step 9 on page 9.
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— No, I will enter static IP information.

You can have a specific IP address for the terminal. This is 
selected automatically if the network does not have DHCP or 
the terminal is not properly connected to the network.

If this is selected automatically in a network with DHCP 
configured and running, the terminal cannot get its IP 
address and communicate on the network. Verify that the 
terminal is properly connected to the network, then restart 
the terminal. The setup wizard should detect the DHCP 
server and select the DHCP option.

7. If you chose static IP addressing, enter settings, then click Next.

— IP Address

Required. The IP address for the terminal.

— Subnet Mask

Required. The subnet mask for the network subnet class. If 
the network is subnetted, enter the mask for the terminal’s 
subnet.

— Gateway

Optional. The address of the device that the subnet uses to 
communicate with another network.

8. If you chose static addressing, enable or disable DNS or WINS 
name resolution services and provide network information, then 
click Next.

Windows hosts support both WINS and DNS name resolution 
services. The DNS server can be a Windows  server or a UNIX 
host. The selected services must be properly configured and 
available on the network. Select either or both services:

— Enable DNS

— Enable WINS
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Provide the following network information:

— Default Domain Name (DNS only)

The TCP/IP domain for the DNS server. If you specify a 
default domain name and a primary server IP address, users 
can identify a server by its host name.

— Primary Server IP Address

The IP address of the DNS or WINS server that resolves 
device names.

— Secondary Server IP Address

The IP address of the DNS or WINS server that resolves 
device names if the primary server cannot resolve them.

9. Choose a display resolution and click Test to check it. When it is 
acceptable, click Next.

You can use almost any monitor with the terminal. Newer 
monitors support the DDC (Display Data Channel) protocol, 
version 2.0, that lets a computer's video chip query monitors and 
adjust video settings to get the best desktop area and refresh rate 
the monitor supports. The screen flickers less with a higher 
refresh rate; you should specify at least 70 Hz.

With the default option, Best Available Using DDC, the terminal 
checks for a DDC 2.0 compliant monitor.

If the monitor is DDC 2.0 compliant, the terminal sets the display 
to the best resolution the monitor supports. NCD ThinSTAR 
terminals support the following resolutions, all at an 85 Hz 
refresh rate: 

NCD ThinSTAR 200 terminals Up to 1024 x 786
NCD ThinSTAR 232 terminals Up to 1600 x 1200
NCD ThinSTAR 300 terminals Up to 1600 x 1200
NCD ThinSTAR 300 TR terminals Up to 1600 x 1200
NCD ThinSTAR 332 terminals Up to 1280 x 1024
NCD ThinSTAR 400 series terminals Up to 1600 x 1200
NCD ThinSTAR 500 terminals Up to 1280 x 1024
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If the monitor is DDC 2.0 compliant, but you want a specific 
resolution, select and test the resolution.

Note The NCD ThinSTAR 500 and 332 terminals are DDC 1.0 
and 2.0 compliant.

If you select Best Available Using DDC and the monitor is not 
DDC 2.0 compliant or cannot be identified, the terminal uses 
800 x 600 and 75 Hz, but continues to display Best Available 
using DDC as the setting.

If you get the default 800 x 600 desktop, the monitor may still 
support a better resolution. To check and select a higher 
resolution, see Display Properties on page 30. If the test pattern, a 
bordered rectangular grid, is not distorted or skewed, the 
monitor supports the resolution.

After completing the setup and connection wizards, check the 
Inventory > Graphics tab as shown on page 67 to see which 
resolution DDC selects.

10. Assign a name to identify your terminal.

If you have NCD ThinPATH Manager, an optional product, you 
can use the name with the Configuration Tool and the Remote 
Restart Tool. The name is an identifier; it is not a network 
address.

Note Some ThinPATH software products (ThinPATH Plus, for 
example) may treat the terminal name as a network 
name.

11. If a printer is attached to your terminal and you want to use it 
with Microsoft Terminal Server Client connections to Windows 
2000 servers, click Yes (otherwise, click No), then click Next.

If configuring the printer:

— Select the port the printer is to use, then click Next.

— Select the printer manufacturer and model, then click Next.

— Enter a printer name to identify the printer, then click Next.
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— Choose whether to make this the default printer, then click 
Next.

— Choose whether to configure another printer, then click Next.

12. To review or change previous settings, click Back, then click 
Finish to apply the settings. The terminal restarts, if necessary.

After initial setup, you can use Terminal Properties to change the 
configuration, as described in Configuring Terminal Properties on 
page 25.

The setup wizard does not reappear unless the terminal performs a 
software recovery or you reset the terminal to factory defaults as 
described in  on page 23.

Introduction to Connections
Terminals can connect to a Windows Terminal Server through LAN 
connections and modem connections.

Three clients, each with its own communication protocol, provide 
those connections:

� Microsoft Terminal Server client connections

The Microsoft Terminal Server client uses the RDP protocol to 
connect to a Windows Terminal Server.

� Citrix ICA connections

The Citrix ICA client uses the ICA protocol to connect to a server 
running Citrix WinFrame or to a Windows Terminal Server 
running Citrix MetaFrame.

� Microsoft Internet Explorer connection

Terminals can connect to the internet using the Microsoft Internet 
Explorer browser.

A fourth client, the NCD dial-up client, provides network access for 
an RDP or ICA session over a modem. There is optional connection 
software to access mainframes or UNIX systems that you can 
purchase through NCD.
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Creating Connections
You create Microsoft Terminal Server and Citrix ICA connections 
with connection wizards and administer them with the Connection 
Manager. You create a web connection using Terminal Properties.

After terminal setup, the connection wizard for the default client 
starts. If the default is a dial-up connection, the dial-up connection 
wizard starts after the client connection wizard. For information 
about these wizards see Managing Terminal Connections on page 70.

If connections exist, the NCD ThinSTAR Connection Manager 
appears instead of a connection wizard.

Going to the Connection Manager
If you are not at the Connection Manager, press Ctrl+Alt+End to go 
there.

Using the Connection Manager
The Connection Manager has a Connections tab for starting or 
ending sessions and a Configure tab for configuring connections. By 
default, the Configure tab is enabled so that you can add, change, 
and delete connections. However, you can disable the tab through 
Terminal Properties to protect the configuration from changes. This 
is explained in Clients on page 53.

Note For information on adding, editing, deleting or stopping a 
connection, see
Managing Terminal Connections on page 70.

In the following example, the Configure tab is enabled.
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Verifying Network Connectivity
After completing the setup wizard and connection wizard, you can 
run diagnostics to verify network integrity to the host in the unlikely 
event that you are having problems.

To verify the connection:

1. Press F2 to go to Terminal Properties, then select Management > 
Network > Diagnostics.

2. Enter the connection’s name (by IP address or host name, if the 
network has a name resolution service) and click Ping.
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Introduction to the Citrix ICA Client

Overview
The Citrix ICA Client lets you make an ICA connection to a Citrix 
server. Once the ICA connection to the Citrix server is established, 
you can access applications and work with files as if you were 
working at the Citrix server itself.

Features
The Citrix ICA Client has the following features:

� TCP/IP+HTTP browsing

� PNLite Mode

� SpeedScreen

� Enhanced resolution and color depth

� Basic and strong encryption

� Auto-reconnect to disconnected sessions

� Client device mapping

— Client printer mapping

— Client com port mapping

� Sound support

� Data compression

� ICA Client hotkeys

� Transparent clipboard access

� Application publishing support

� Business Recovery

Some client features are available only when connecting to 
MetaFrame for Windows and MetaFrame for Windows 2000 servers.
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TCP/IP+HTTP Browsing

This feature enables retrieval of Citrix server and published 
application information across network configurations that restrict 
broadcast packets or the UDP protocol. Very simply, the method 
used to obtain a list of published applications has been enhanced to 
allow the ICA client to obtain published application information 
from Citrix servers located behind firewalls.

PN Lite Mode

PNLite is a connection mode that allows you to connect to an NFuse 
enabled Citrix server and obtain a list of published applications that 
you can connect to. In this mode, you do not have to manually 
configure each ICA connection, but a list of published applications 
will be 'pushed' (made available) to your client device. Connect to 
any published application in that list by double-clicking on an entry.

SpeedScreen Latency Reduction

SpeedScreen latency reduction enhances the user's experience on 
slower network connections. SpeedScreen latency reduction 
functionality includes:

� Local Text Echo

This ICA Client option accelerates the display of the input text on 
the client device.

� Mouse Click Feedback

This ICA Client option provides visual feedback for mouse clicks 
to show that the user's input is being processed.

SpeedScreen latency reduction is only available when it is 
supported and enabled on the Citrix server to which you are 
connecting.

Enhanced Color Depth

The ICA client now enables you to configure higher color depth. 
Depending on the NCD ThinSTAR’s display setting, you can 
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configure the connection to use 16, 256, or thousands of colors.

Secure ICA

The Citrix ICA client now supports encryption using Citrix 
SecureICA Services. The default encryption level is Basic. Strong 
encryption using the RC5 algorithm is available with SecureICA 
Services. SecureICA Services enables RSA RC5 encryption with 40, 
56, or 128-bit session keys.

Auto-reconnect to disconnected sessions

If for some reason, such as a network error, your ICA connection is 
dropped, the ICA client gives you the option of reconnecting to the 
disconnected session.

Client Device Mapping

Client device mapping allows a remote application running on the 
Citrix server to access printers and devices attached to the NCD 
ThinSTAR.

Client Printer Mapping

Client printer mapping lets users access printers attached to the 
NCD ThinSTAR from applications running in an ICA session. When 
a Citrix server is configured to allow client printer mapping, 
applications running remotely on the Citrix server can print to local 
printers.

Client COM Port Mapping

Client COM port mapping is similar to printer mapping. It allows 
users to access serial devices on the NCD ThinSTAR as if they were 
connected to the Citrix server.

Note that client COM Port mapping is not supported when 
connecting to MetaFrame for UNIX Operating Systems 1.0 and 1.1 
servers.
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Sound Support

Sound support allows your NCD ThinSTAR to play sounds 
generated by applications running on the Citrix server. Sound 
support can be configured to use one of three different compression 
schemes. Each scheme provides different sound quality and 
bandwidth usage. This feature is not available when connecting to 
MetaFrame for UNIX 1.0 and 1.1 servers.

Data Compression

Data Compression can increase performance over low speed 
asynchronous and WAN connections by reducing the amount of 
data sent over the communications link to the client computer.

ICA Client Hotkeys

The Citrix ICA Client provides hotkeys that can be used to control 
various functions while in an ICA session. Some hotkeys control the 
behavior of the ICA Client itself while others emulate standard 
Windows hotkeys.

Transparent Clipboard Access

You can cut and paste objects between ICA sessions and applications 
running locally. Access to the local clipboard requires no special 
configuration or procedures. Use the familiar cut, copy, and paste 
commands to transfer text, pictures, and other objects between local 
and remote applications.

Published Application Support

You can create a remote application entry to connect to a Citrix 
server or to a published application that contains all of the 
information necessary to launch a user session or an application.

Business Recovery

The Citrix ICA Client includes the additional intelligence to support 



18 NCD ThinSTAR Terminal User’s Guide

Introduction to Terminal Properties

multiple server sites (such as primary and hot backup) with different 
addresses for the same published application name. This feature 
provides consistent connections to published applications in the 
event of a primary server disruption.

Introduction to Terminal Properties
Terminal properties are the configuration values for NCD ThinSTAR 
terminals. You define terminal properties when you configure the 
terminal with the setup wizard. After setup, you can view and 
modify settings through Terminal Properties, as described in this 
section. Property descriptions are in Configuring Terminal 
Properties on page 25.

Terminal Properties software presents all configuration values and 
hardware, software, and network inventory details in one place. The 
information is organized on the following tabs:

� General — identifies the product and provides an option for 
resetting all configured values to factory defaults.

� Input — has settings for the keyboard and the mouse.

� Display — has settings for the monitor, including resolution, 
refresh rate, and a screen saver.

� Network — has basic settings for network addresses.

� Security —provides password protection.

� Management — has tabs with settings for pointer speed, audio, 
touchscreen (available on supported terminals), the Management 
Server, hotkeys, network, monitor power, and clients. The 
network information on the Management tab provides 
additional networking options and includes diagnostics.

� Extensions — lists additional terminal options, including 
identification and wireless options and configuration options for 
the Microsoft Internet Explorer browser.

� Inventory — has tabs with information about hardware, 
software, the network, and graphics.
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Access to Terminal Properties
If you are at the Connection Manager, press F2 to start Terminal 
Properties. If you are not at the Connection Manager, press 
Ctrl+Alt+End to go there, then press F2 to go to Terminal Properties.

Password Protection
You can protect the terminal configuration with a password. If a 
password exists, terminal properties are visible, but you must enter 
the password to change properties except those on the following 
tabs: 

F2 Key

Ctrl+Alt+End 

Access to Terminal 
Properties may be 
disabled through 
NCD ThinPATH 
Manager, an optional 
product.
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— Input 

— Display 

— Management > Pointer 

— Management > Audio 

— Management > Power

— Management > Touchscreen

Saving or Ignoring Changes and Exiting
After viewing or modifying configuration settings, you can save or 
cancel changes and exit.

The Apply button, the OK button, and the Cancel button perform 
these functions, as follows:

Use the Apply button to apply changes on each tab, then to use the 
OK button when you are ready to exit Terminal Properties.

Assigning a Management Server to a Terminal
A Management Server is an NCD utility that runs on a Windows  
server and can be configured to automatically replace outdated or 
corrupt Operating Software. You can run a management server on 
the local subnet or on a remote subnet.

Button Result

Apply Saves changes and remains in Terminal Properties.

OK Saves changes and closes Terminal Properties, then 
returns to the Connection Manager.

Cancel Closes Terminal Properties. Any changes that you did 
not apply are lost.
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Note By default, terminals broadcast for the Management Server 
on their local subnet. If you have one Management Server for 
each subnet, you do not need to assign a Management Server. 

To assign a Management Server to a terminal:

1. In Terminal Properties, select Management > Server and enter 
the IP address of the Management Server.

2. Restart the terminal.

Multiple Management Servers on One Subnet

It is possible to have multiple installations of NCD ThinSTAR 
Operating Software on the same subnet, but NCD does not 
recommend this type of installation.

If you feel that multiple Management Servers are needed on the 
same subnet, please contact NCD Technical Support. They can assist 
you with planning and implementing the installation.

Keyboard Navigation
You can use the keyboard to navigate within Terminal Properties. 
When you are on a tab, you can use the Alt key with an underlined 
letter to go to a property and change its value.

Going to a Property or Button

� Going to a slider moves the cursor one unit lower or higher. For 
example, in the Management > Audio tab, for Volume, Alt+L 
moves the cursor one unit lower and Alt+H moves the cursor 
one unit higher.

� Going to a checkbox toggles its value. For example, if the Enable 
box is checked, using Alt+E disables the property.

� Going to a button activates the button. For example, Alt+A goes 
to the Apply button and applies changes.
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Once in a property, you can use the underlined letter without Alt to 
go to properties or buttons on the same tab. For example, in Volume, 
you can press T to activate the Test button. This shortcut is not 
available for list boxes or fields that allow you to edit information.

Cycling Through Tabs, Properties, and Buttons

Press the Tab key to cycle down through a main property tab and its 
contents or press the Shift+Tab key to go in reverse tab order.

For example, from the Management > Audio tab, you can press Tab 
to go through rows of tabs, properties, and buttons as follows: Audio 
tab, Volume field, Mute button, Test button, Enable button, OK 
button, Cancel button, Apply button (if you made any changes). 
After cycling down, you start back up at the Management tab.
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The following sections are intended for administrators or users who 
configure NCD ThinSTAR terminals.

The configuration values are called terminal properties, and they are 
presented on a series of tabs named as follows: General, Input, 
Display, Network, Security, Management, Extensions, and Inventory.

General Properties
The General tab identifies the product and provides an option for 
resetting all configured values to factory defaults.

Resetting the defaults does the following:

� Deletes all connection information and clients other than the 
Microsoft Terminal Server Client and the Citrix ICA Client.

� Resets terminal property settings to their factory values.

� Starts the setup wizard.

Resetting Values to Factory Defaults
NCD has set default configuration values for a terminal, and you can 
restore them. Any connections that you have created are lost.

To reset factory default values:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select General.
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3. Check Reset the terminal to factory-default property settings.

4. Answer Yes when asked about restarting the terminal.

Restarting the terminal starts the setup wizard.

Factory Default System Settings

The factory default system settings are as follows.

� All defined connections are removed.

� All optional software is removed.

� SNMP is in read-only mode.
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Factory Default Property Settings

The factory default property settings are as follows

Factory Default Property Settings

Tab Attribute Default Setting

Input Keyboard English (United States).

Mouse Right-handed.

Character Repeat The shortest delay; midway between the fastest and 
slowest rate.

Display Desktop Area and 
Refresh Frequency

Best Available Using DDC.

Screen Saver Enabled, with a timeout of 20 minutes.

HighColor Disabled.

Network IP Address Get an address from a DHCP server. Existing IP 
address entries are removed.

Advanced

Network

Enable DNS Filled with data from DHCP.

Enable WINS Filled with data from DHCP.

Security Password No password.
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Management Pointer Speed Four units above slow.

Audio High volume.

Microphone disabled (microphone not available on 
NCD ThinSTAR 200).

Touchscreen Disabled.

Server Undefined.

Hotkeys Enabled.

Network LAN connection; network speed sensed 
automatically.

DHCP timeout of 60 seconds. 

Management Server timeout of 5 seconds.

Host resolution timeout of 5 seconds. 

Send count of 5.

Power No settings.

Clients Microsoft Terminal Server Client.

English (United States) locale.

Configure tab of Connection Manager enabled.

Extensions* Terminal identification Unique ID based on MAC address.

Wireless Network DHCP

IE Browser Disabled.

Inventory Network information Reports IP address changes caused by reset to 
defaults on Network tab and Display tab.

Factory Default Property Settings (continued)

Tab Attribute Default Setting
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* Note Your list may vary depending on the terminal model.

Input Properties
On the Input tab, you can select a keyboard locale, modify mouse 
button actions, and set character repeat options.

To set input properties:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Input.

3. Modify properties as desired, then click OK or Apply to put them 
into effect.

— Keyboard

Select a keyboard type from the list of locales.

— Mouse

Select Right-handed or Left-handed.
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— Character Repeat

Move the sliders. Repeat delay tells how long to wait before a 
pressed key starts repeating. Repeat rate specifies how 
quickly the character repeats after a key is pressed.

Display Properties
Display properties include screen resolution and the screen saver.

To set display properties:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Display.

3. Modify attributes as desired, then click OK or Apply.

— Desktop Area and Refresh Frequency

The default, Best Available Using DDC, automatically 
establishes the optimal setting. For another setting, click Test 
to check it. If the grid is not displayed or is distorted, click No 

If you restart the 
terminal and the screen 
goes blank after the 
logo, settings are 
incorrect. See the 
troubleshooting 
information in 
Unreadable Display on 
page 13 of the NCD 
ThinSTAR Terminal 
Administration Guide.

Properties defined on 
the Management > 
Power tab and 
discussed on page 52, 
can reduce power use 
even more than the 
screen saver.
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when asked, then try another setting. When the grid is 
acceptable, click Yes.

— HighColor

Provides 16-bit color for those sessions that support it. Both 
ICA and Microsoft Internet Explorer support HighColor. 
HighColor is available for a subset of Desktop Area and 
Refresh Frequencys listed. You should select the Desktop 
Area and Refresh Frequency, and, if available, HighColor. 
Not all resolutions are supported in 16-bit color mode.

— Enable Screen Saver

By default, the monitor displays a blank screen saver after the 
terminal is idle for a set time. You can enable this or disable it.

— Wait n Minutes

The number of minutes the terminal is idle before the screen 
saver is used. The default is 20; the maximum is 300.

Network Properties
Every terminal needs a valid IP address to identify itself to the 
network. NCD ThinSTAR terminals support dynamic IP assignment 
through DHCP or manual assignment of a static IP address. 
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If you choose static addresses, you can make name resolution choices 
as well.

With name resolution services, you can identify a server by its host 
name instead of its IP address when you create a connection. 
Terminal Server hosts and NCD ThinSTAR terminals support two 
name resolution services, DNS and WINS, to map host names to IP 
addresses. 

You can enable terminals to use DNS, or WINS, or both.

� DNS

You need DNS (Domain Name System) to resolve host names 
across the world-wide web. You can set up DNS service on any 
Windows server or UNIX-based server in the network.

� WINS



NCD ThinSTAR Terminal User’s Guide 33

Network Properties

WINS (Windows Internet naming Service) detects devices’ 
current IP addresses and automatically updates its database. 
Using WINS with DHCP fully automates IP assignment and 
name resolution. You can set up WINS on any Windows server.

� DNS and WINS

A network can use both DNS servers and WINS servers to 
resolve host names.

If a terminal starts a connection and both services are on the 
network, the host name first goes to the DNS server to be 
resolved to an IP address. If the DNS server cannot resolve it, the 
name goes to the WINS server.

The following are general guidelines for choosing a service:

If the terminal is in dial-up mode, IP information comes from the 
dial-up connection, so you cannot select DHCP or enter static IP 
addresses. However, any settings you make when the terminal is in 
LAN mode are preserved. (To change the network connection mode, 
see Network on page 49.)

If the terminal uses DHCP, you cannot change values that DHCP 
supplies, but you can change other values.

To choose an addressing mode:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Network.

Use If … Additional Options

DNS You have a UNIX or mixed-platform 
environment or you need to create 
connections across subnets.

May also use WINS, if 
desired.

WINS All networked devices are based on 
Microsoft Windows and are in the same 
subnet.

May also use DNS, if 
desired.
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3. Select an addressing mode and provide information as needed, 
then click Apply or OK.

— Obtain an IP address from a DHCP server

DHCP is enabled by default and provides an IP address each 
time the terminal starts.

— Specify an IP address

As an alternative to DHCP, you can assign the terminal’s IP 
address and other addresses.

IP Address. Required. Identifies the terminal.

Subnet Mask. Required. Identifies the range of addresses that 
belong to the subnet.

Gateway. Optional. The machine a subnet uses to 
communicate with another network.

If you specify an IP address, the Advanced Network button is 
enabled and you can specify how the system resolves host names to 
IP addresses for a connection. If you want to do this, click the button 
and provide information for either or both services, then click OK.

Enable DNS. Use the Domain Name System to resolve host 
names. If DHCP provides IP addresses, it also provides DNS 
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information. Enable DNS only if you know that your 
network provides it and you have the DNS servers’ IP 
addresses. The DNS servers can be either Windows or UNIX 
hosts.

Enable WINS. Use the Windows Internet Naming Service 
(WINS) to resolve host names. If DHCP provides IP 
information, it also provides WINS information.

Provide information for these services as follows:

Default Domain. This applies only to DNS and shows which 
TCP/IP domain the DNS server resides in.

Primary Server IP Address. The IP address of the DNS or 
WINS server that is to resolve device names. 

Secondary Server IP Address. The IP address of the DNS or 
WINS server that is to resolve a device name if the primary 
server cannot resolve it.

Security
To increase security, you can require a password to change properties 
and define which tabs and properties can be changed.

Password Security
You can create a password to restrict access to terminal properties, 
then change it as needed.

Create a Password

You create a password on the following screen.
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To create a password:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Security. If no password exists, this tab contains the Create 
Password tab.

3. Enter the password in the Password field. Enter it exactly in the 
Confirm password field and press Enter or click Create. The 
password exists; you do not need to click OK or Apply to save it.

When you create the password, the Create Password tab is 
replaced by the Change Password and Terminal Properties 
Access tabs.

If you start to enter a password, then leave the tab, the terminal 
warns you when you try to exit Terminal Properties.

Enter the Password

If a password exists, the Security tab displays the Enter Password 
tab.
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To enter the password:

1. Type the password in the Password field.

2. Click the Enter button or press Enter.

The Security tab now displays the Change Password tab and 
Terminal Properties Access tab. You can change the password, if 
desired, or go to another tab.

Change the Password

You change the password on the following screen:
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To change the current password:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Security > Enter Password and enter the password.

After you enter the password, the Change Password tab and the 
Terminal Properties Access tab replace the Enter Password tab.

3. If the Old password field is blank, enter the old password and 
press Enter. The Old password field is filled in (and displays 
asterisks) if you have just created a new password.

Enter a new password in the New password field and press 
Enter. (If you enter characters in the New password field, then 
leave the tab without completing the process, the terminal warns 
you when you try to exit Terminal Properties.)

4. Enter the same password exactly in the Confirm password field 
and press Enter.

5. Click Change or press Enter.

A message lets you know that the password was changed.
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Delete the Password

To delete the current password:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Security > Enter Password and enter the password.

After you enter the password, the Change Password tab and the 
Terminal Properties Access tab replace the Enter Password tab.

3. Enter the current password in the Old Password field and leave 
the other fields blank.

4. Click Change.

When the password is deleted, the screen displays the Create 
Password tab. At this point, you can go to another tab or click OK 
to exit Terminal Properties.

Define Access to Individual Tabs and Properties
Using the Terminal Properties password, you can protect fields and 
tabs from changes. By default, if you create a password and the user 
does not enter it, the user can change only the fields on these tabs:

� The Input tab

� The Display tab

� The Management > Pointer tab

� The Management > Audio tab

� The Management > Touchscreen tab

Note Touchscreen is not available on the ThinSTAR 200 
terminal.

� The Management > Power tab

A user can always change fields after entering the password.
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You can change the defaults through the Management > Terminal 
Properties Access tab, which appears if you are using a password.

To configure access to fields and tabs:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Create a password as described on page 35 or enter the password 
as described on page 36.

3. Select Security > Terminal Properties Access.

4. Set access properties, then click OK or Apply.

Each line in the Properties list identifies a field or tab and shows 
its protection status.

— If the Protected status for a field or tab is set to Yes, a user 
must enter the password to access it; if the user does not 
enter the password, the field is grayed out.

— If the Protected status is No, the user has access to the field or 
tab without entering a password.
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To change protection status, select one or more items and click 
Protect or Unprotect. To reset all fields to their default protection 
status, click Set All to Defaults.

Management Properties
The Management tab is organized into a series of tabs that you can 
use to set properties and perform actions such as tests:

Management Properties

Main Tab Properties/Functionality

Pointer Adjust the speed of the pointer.

Audio Set the volume level or choose to mute sounds.

Test the volume.

Enable the microphone for terminals that support it. It is not 
available on NCD ThinSTAR 200 terminals.

Touchscreen Enable touchscreen, for monitors that support it. It is not 
available on NCD ThinSTAR 200 terminals.

Identify the port for the touchscreen monitor.

Calibrate the screen.

Server Select a Management Server to provide updates to the 
terminal.

Hotkeys Enable hotkeys to cycle through connections.

Network Specify the type (LAN or dial-up) and speed.

Set timeouts for DHCP and the Management Server.

Perform diagnostics.

Power Provide power information for monitors.
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Pointer
You can change how fast the mouse pointer moves on the desktop 
when you move the mouse.

To set the pointer speed:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Pointer.

Clients Set a default client.

Configure a client, including printers for RDP connections.

Choose a terminal locale.

Enable or disable the Configure tab in the Connection 
Manager.

Management Properties

Main Tab Properties/Functionality
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3. Use the slider to select a speed, then click Apply and move the 
mouse to test the speed, If you want to return to the default 
speed (the fourth mark), click Default, then click OK or Apply.

Audio
The Audio tab has options for terminal speakers and microphone 
input.

l

To configure audio:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Audio.

3. Set properties, then click OK or Apply.

— Speaker Volume

Use the slider to set the volume of the speakers, then click 
Test to hear the volume at that setting.

— Speaker Mute
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Mute turns audio on or off.

— Microphone Enable

Enable enables or disables microphone input. By default, the 
microphone is disabled. (This is not available for 
NCD ThinSTAR 200 terminals.)

Touchscreen
If your monitor supports touch input, you can enable touchscreen. 
This disables mouse input and removes mouse and pointer options 
from the Input and Pointer tabs. The NCD ThinSTAR 200 terminals 
do not support touchscreen. 

To set touchscreen properties:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Touchscreen.

3. Set properties, then click OK or Apply.

If you enable 
touchscreen and do not 
have a touchscreen 
monitor or enter the 
wrong COM port, see 
Touchscreen 
Troubleshooting on page 
45.
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— Enable

You can enable or disable touchscreen.

— Select COM port to which you have connected the 
touchscreen

If you enable touchscreen, specify the communications 
(COM) port. The touchscreen must be connected to the port 
with a serial cable. A touchscreen monitor detects which port 
it is on and makes it the default.

4. Restart the terminal to put touchscreen into effect.

When the terminal restarts, the calibration program runs if you 
have not yet calibrated for the current display resolution. Follow 
instructions presented to define the corners of your screen.

5. Return to the Management > Touchscreen tab and click Calibrate 
to calibrate the touchscreen. Follow instructions presented to 
define the corners of your screen.

If you selected the wrong port or switched from a touchscreen to 
a non-touchscreen monitor, see recovery procedures in 
Touchscreen Troubleshooting on page 45.

Touchscreen Troubleshooting

In touchscreen mode, the calibration program runs when a new 
display resolution is selected and the terminal restarts. Two errors 
may cause the touchscreen calibration program to time out.

No Touchscreen Monitor

If you switch from a touchscreen to a non-touchscreen monitor, 
the calibration program times out after 30 seconds.

To correct this:

— You can wait for the calibration timeout or press Esc to cancel 
the calibration program.

— When the calibration program ends, press F2 to return to 
Terminal Properties.
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— Use the right arrow key to move to the Management tab, then 
press Tab to go to the Pointer tab. Use the right arrow key to 
move to the Touchscreen tab.

— Press Alt+E to disable touchscreen.

— Press Alt+A to apply the changes.

— Restart the terminal.

Wrong COM Port

If you have the wrong COM port:

— If the physical connection is wrong, connect the serial cable to 
the other COM port on the terminal. 

— You can wait for the calibration timeout or press Esc to cancel 
the calibration program.

— When the calibration program ends, press F2 to return to 
Terminal Properties.

— Use the right arrow key to move to the Management tab, then 
press Tab to go to the Pointer tab. Use the right arrow key to 
move to the Touchscreen tab.

— Press Alt+S to go to the list of COM ports, then use the up or 
down arrow to select another port.

— Press Alt+A to apply the changes.

— Restart the terminal.
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Server
The NCD ThinSTAR Management Service (TMS), automatically 
updates NCD ThinSTAR Operating Software on terminals. It can be 
installed on any Windows server in the network. By default, the 
terminal broadcasts on the terminal’s subnet to locate the 
Management Server. However, you may want to use a specific 
Management Server on a different subnet.

To choose a Management Server for software updates:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Server.

3. Enter the IP address of the Management Server that is to update 
the Operating Software on this terminal, then click Apply or OK.

If name resolution service is available, you can use the host 
name. If you have specified a gateway, you can specify a 
Management Server on a different subnet.
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Hotkeys
You can enable hotkeys so that users can use the following key 
sequences to switch connections during a running session.

You set hotkeys on the Hotkeys tab.

To enable connection hot keys:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

Hot Key Use

Ctrl+Alt+↑ Cycle up through active connections in the 
Connection Manager.

Ctrl+Alt+↓ Cycle down through active connections in 
the Connection Manager.

Ctrl+Alt+Home Go to the default connection.The connection 
is started if it is not already active.
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2. Select Management > Hotkeys.

3. Select Enable Connection Hotkeys, then click Apply or OK.

Network
The terminal can communicate over a modem or a LAN. For a LAN, 
you can specify the network speed or have the terminal sense it.

Network Connection Type

You set the network connection type on the Type tab.

To set the network connection type and options:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Network > Type.

3. Select a type and provide information, then click OK or Apply.
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— LAN Connection

Select a network speed. NCD recommends Automatically 
Sense Network Speed. (100 Mbps is unavailable on 
NCD ThinSTAR 200 terminals.)

— Dial-Up Connection

You can allow software upgrades over the modem, but it may 
not be desirable because of the download time.

4. Restart the terminal to apply these changes.

Set Timeouts

Timeouts define how long the terminal waits for information from 
the DHCP or Management Server. Switched networks with a 
spanning tree protocol may need longer timeouts.

To specify timeouts:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Network > Timeouts.

Default restores the 
default value, 60 
seconds.

Default restores the 
default value, 5 
seconds.
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3. Enter timeout information, then click Apply or OK.

— DHCP Timeout

The default is 60 seconds. If the terminal restarts in DHCP 
network mode and DHCP information is not available, a 
timer counts down from the timeout value until the server 
responds or you click Cancel.

— Management Server Timeout

The default is 5 seconds. If the timeout value is more than 5 
seconds and the restarted terminal cannot contact the 
Management Server, a timer counts down from the timeout 
value until the server responds or you click Cancel.

Test Network Connections

From the Diagnostics tab, you can test a network connection.

To test the connection:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Network > Diagnostics.
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3. Enter diagnostic information, then click Ping:

— Host Resolution Timeout

Specify how long to wait for host resolution after you click 
Ping. The default is 5 seconds.

— Send Count

Enter the number of times to ping the host.

— Host to Ping

Enter the host name or IP address.

Status information includes a Cancel button you can click to end 
the test. The host replies or error messages appear.

4. Click OK or Apply.

Power
Screen savers reduce power use. Power settings go further.

To make power settings:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

The screen saver 
timeout cannot exceed 
the suspend timeout 
and the suspend 
timeout cannot exceed 
the powerdown timeout.
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2. Select Management > Power.

3. Enter power information, then click OK or Apply.

— Monitor is Energy Star compliant

For a DDC monitor, the terminal sets this and you cannot 
change it. For other monitors, specify whether it is Energy 
Star compliant. You can set timeouts for an Energy Star 
compliant monitor, using the following formula:

Screen Saver Timeout <= Suspend Timeout <= Powerdown Timeout

— Suspend Timeout. Turns off some power, but lets you activate 
the screen quickly. Give the number of minutes before the 
suspend state begins.

— Powerdown Timeout. Turns off most power, but leaves the 
mouse and keyboard active. Give the number of minutes 
before powerdown begins. It takes several seconds longer to 
return from powerdown state than from suspend state.

Clients
On the Clients tab, you can set a default client, configure some 
clients, set the terminal locale, and enable connection configuration.

Properties for some 
clients can be set 
through Terminal 
Properties. If you can set 
global options for the 
client here, the 
Configure Client button 
is available.
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To set client properties:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Management > Clients.

3. Enter information, then click OK or Apply.

— Set Default Client

The Connection Manager lists this client first in add mode.

— Configure Client

If this is available, you can set options. For Citrix ICA 
settings, see ICA Connections on page 76; for RDP printers, 
see RDP Connections on page 71.

— Terminal Locale

The language your terminal uses to communicate with the 
Windows Terminal Server.

— Display Connection Manager’s Configure Tab

By default, the Configure tab of the Connection Manager is 
visible so you can set up connections, but you can hide it.

Extension Properties
The Extensions tab lists additional terminal configuration options. 
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To display properties for an extended option, double click it or 
highlight it and press Enter or the spacebar key.

Wireless Network Properties
Wireless networking is supported on a number of NCD ThinSTAR 
terminals. You can maintain properties for both Ethernet and 
wireless connections, but only one type of connection can be active at 
a time. If the Ethernet cable is attached to the terminal, then the 
terminal uses that wired network to communicate. If the network 
cable is not attached to the terminal, then the terminal uses the 
wireless network to communicate.

For wireless connections, there are properties for addresses, name 
services, and Proxim cards.
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Terminal Identification Properties
You can identify a terminal by name. This is especially useful if you 
have NCD ThinPATH Manager, which manages multiple terminals.

To set terminal identification properties:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Extensions, then select Terminal Identification.

3. Enter a terminal name. You cannot exceed 15 characters.

4. If desired, add information about the terminal in the Comment 
and Customer reserved fields. These fields can extend beyond 
the length of the white box.

Configuring Internet Explorer
To allow an Internet Explorer session on a terminal:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Extensions and then double-click IE Browser.

3. Click Enable Web Connection. Once selected, a Web connection 
appears in the NCD ThinSTAR Connection Manager. Only one 
Web connection per terminal is allowed.

Note This is the only mandatory browser configuration item. 
Changing other browser configuration items is optional.

The Group 
subclasses field 
is for information 
only; the 
NCD ThinPATH 
Manager 
Configuration 
Tool can set the 
value.
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4. Change browser preferences as appropriate. See Browser 
Options for explanations of available options.

Note To delete the web connection from the Connection Manager, 
deselect the Enable Web Connection checkbox.

Browser Options

Configurable browser items include:

Internet Explorer 
4.0 Properties

Option Default Option

Home page The internet address for the current 
home page.

The home (start) page is the page 
you see each time you start Internet 
Explorer. You can return to the 
home page at any time by clicking 
the Home button on the toolbar.

http://www.ncd.com

Search page The Internet address for common 
searches. You can return to the 
search page by clicking the Search 
button on the toolbar.

http://www.msn.com

Persistent 
browser cache

Stores History and Cookies 
portions of the browser cache 
across Web sessions. 

Note The browser cache is not 
retained when the terminal 
powers off.

Selected

Enable Favorites Stores Favorite information across 
Web sessions.

Selected
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Preferences Options Default Option

When do you 
want the 
browser to 
underline 
hyperlinks?

� Never – Hyperlinks on a page 
are not highlighted.

� Always – Hyperlinks on a page 
are always highlighted.

� Hover – Hyperlinks are only 
highlighted when the mouse is 
over the link

Never

What size font 
do you want to 
use?

� Very small

� Small

� Normal

� Large

� Very Large

Normal

Proxy 
Information

Option Default Option

Access the 
Internet using a 
proxy server.

� Not selected – No proxy server is 
used.

� Selected – Connections go 
through your local area 
network’s proxy server before 
reaching the Internet. A proxy 
server acts as a security barrier 
between your internal network 
(intranet) and the Internet. 

Not selected – no proxy 
server is used.

Proxy server 
name or IP 
address

� The IP address of your local area 
network’s proxy server.

No default value.
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Port � The port number for your local 
area network’s proxy server.

80 – The typical proxy 
server port.

Bypass proxy 
server for local 
(Intranet) 
addresses

� Specifies whether you want to 
use the proxy server for all local 
(intranet) addresses. You might 
be able to gain access to local 
addresses easier and faster if you 
do not use the proxy server.

Selected – The proxy server 
is not used for intranet 
connections.

Advanced Proxy 
Settings

Options Default Option

Exceptions � Specifies a list of proxy server 
addresses to be bypassed. The 
addresses are separated by 
semicolons.

Undefined.

Proxy 
Information

Option Default Option
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Configure 
Startup

Options Default Option

Make Web 
Connection your 
default 
connection

� Not selected – The Web 
connection, in the NCD 
ThinSTAR Connection Manager, 
is not the terminal’s default 
connection.

� Selected – The Web connection, 
in the NCD ThinSTAR 
Connection Manager, is the 
terminal’s default connection. 
Pressing Control+Alt+Home 
either starts that default 
connection or transfers control to 
the already running connection.

Not selected – The Web 
connection is not the 
terminal’s default 
connection.
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Inventory Properties
The Inventory tab has additional tabs with information about the 
terminal’s hardware, software, the network, and graphics. It also has 
an About tab.

To view inventory properties:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Inventory.

The information on the Inventory tab can be useful for verifying 
hardware and software versions, confirming a successful 
software upgrade, and reporting problems to NCD Technical 
Support.

Automatically 
start the Web 
connection at 
startup.

� Not selected & grayed out – The 
Web connection is not started 
when the terminal powers on. 
Also, the Web connection is not 
the default connection.

� Not selected – The Web 
connection is the terminal’s 
default connection. However, the 
connection does not 
automatically start when the 
terminal powers on.

� Selected – The Web connection is 
automatically started when the 
terminal powers on. Pressing 
Control+Alt+Home transfers 
control to the Web connection.

Not selected and grayed 
out 

Configure 
Startup

Options Default Option
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The Hardware tab has the following information:
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The Software tab has tabs for system information and installed 
software, including optional software such as terminal 
emulations.
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The Identification tab has the name that identifies the terminal. 
For a long field, use the right arrow to scroll to the right.



NCD ThinSTAR Terminal User’s Guide 65

Inventory Properties

The Network Settings tab has three tabs, showing addresses, 
name services, and miscellaneous information.

The Addresses tab shows network addresses:

If the terminal is in 
dial-up mode, the IP 
address shown is the 
address returned from 
the dial-up connection. 
The dial-up network 
protocol (PPP or SLIP) 
supplies this address.
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The Name Services tab shows which servers provide name 
resolution service for DNS and WINS name services.
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The Misc. tab shows miscellaneous information, including the 
connection type and network speed.

The Graphics tab has the following information.

Your configuration may 
differ from what is on 
this screen to reflect 
your network 
environment.
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The About tab has information for the NCD ThinSTAR terminal.
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The following sections contain reference information for managing a 
terminal’s connections, including Microsoft Terminal Server (RDP) 
connections and Citrix ICA connections. For introductory 
information on connections see Introduction to Connections on page 
11. You create connections with connection wizards and administer 
them with the Connection Manager. 

The Connection Manager has a Connections tab for starting or 
ending connection sessions and a Configure tab for configuring 
connections.
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By default, the Configure tab is enabled and configuring connections 
is allowed. However, it is possible to protect the configuration by 
disabling the tab, as shown
on page 53.

After you set the terminal up with the setup wizard, the connection 
wizard for your default client starts so that you can define at least 
one connection.

RDP Connections
The Microsoft Terminal Server client uses the RDP protocol. This 
section explains how to add and use Microsoft RDP connections.

Adding and Configuring an RDP Connection
To add an RDP connection:

1. Start the WTS (Windows Terminal Server) connection wizard. 

Note It starts after setup if the default client is Microsoft 
Terminal Server. Later, you can press Ctrl+Alt+End to 
display the Connection Manager, then select the 
Configure tab, click Add, and select the Microsoft 
Terminal Server client as the type.

2. Specify a connection name and server, then click Next.

— Name

The name of the connection, up to 32 characters. Use a name 
that is descriptive.

— Server

The IP address or host name of the Terminal Server to host 
the connection.

You can use a host name only if DNS or WINS is enabled, 
and, for DNS, a default domain was defined through DHCP 
or during setup.
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If there is no default domain or the DNS server and the 
terminal are in different TCP/IP domains, specify a fully 
qualified domain name.

A dial-up connection may need the fully qualified domain 
name or IP address, depending on your PPP service.

— Low Speed Connection

Select this if connecting to the server through a low 
bandwidth WAN or serial line.

3. Enable or disable automatic user logon, then click Next.

By default, automatic user logon is disabled and users must 
provide login data when using the connection. Leave this feature 
disabled if automatic logon poses an unacceptable security risk.

To let a user log on automatically when starting this connection, 
check Automatic Logon and provide logon information:

— Username

The user ID of a local user on a particular server or a global 
user on a Domain Controller.

— Password

The password for the user ID; it is kept in encrypted form on 
the terminal and cannot be displayed.

— Domain

The Windows domain name, if the server belongs to a 
Windows domain and a Domain Controller authenticates 
users.

The name of the server if you want it to authenticate users or 
if it is not a member of a Windows domain.
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4. Choose what to display when the connection starts, then click 
Next.

— Desktop

Display the Windows desktop.

— Application file name

Do not start with the Windows desktop. Instead, start an 
application; when the user closes this application, the 
connection ends.

Enter the directory path and file name of the application. Use 
the full path if it is not specified in the user’s environment on 
the Terminal Server host.

— Working directory

If you specified an application, you can give the path to a 
working directory. By default, the application saves data files 
in that directory.

If you do not specify a working directory, the application 
saves data files in the user’s home directory on the host. 

5. Click Back to review or change previous settings, then return and 
click Finish to apply the settings.

The Connection Manager includes the new connection in its list 
of connections.

If you have just created the first connection and the terminal is in 
dial-up mode, the NCD dial-up client’s connection wizard starts. 
See Adding an NCD Dial-Up Connection on page 98.

Configuring an RDP Printer in Terminal Properties
When you set properties on the Management > Clients tab of 
Terminal Properties, you can set some client properties globally. For 
example, you can configure a printer for RDP connections. To go to 
Terminal Properties from the Connection Manager, press F2.

To configure a printer for RDP connections:
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1. In Terminal Properties, select Management > Clients.

2. Select Microsoft Terminal Server Client and click Configure.

3. Select a printer and click Properties.

4. Enter information:

— Friendly Name

Give a name users will recognize.

— Manufacturers

Select a manufacturer.

— Printers

Select a printer.

5. Choose whether to make the printer the default printer.

Starting an RDP Connection
You start connections from the Connection Manager, which lists all 
connections on its Connections tab. To display the Connection 
Manager when you are in a session, press Ctrl+Alt+End.

A terminal must be in the correct mode—LAN or dial-up—to start a 
connection. To change the mode, see Network Connection Type on 
page 49.

To start an RDP connection:

1. In the Connection Manager, select the Connections tab, then 
double click the name or select the name and click Connect.
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If the connection was correctly defined, and the server is 
running, the connection starts.

If the terminal cannot connect, select the Configure tab. Correct 
the server specification for the connection if it is wrong, then try 
to connect again.

If you have the right server, see whether it is running and check 
whether the terminal is physically connected to the network. Use 
the Management > Network > Diagnostics tab in Terminal 
Properties to do this. For information, see Test Network 
Connections on page 51.

2. Enter logon information—user name, password, and domain—if 
requested. A connection may require logging on manually or the 
user information in an automatic logon connection may be 
wrong or may not be authenticated for that server. The 
connection starts the specified application or the server’s 
desktop, depending on startup options set in Step 4 on page 73 
on page 73.
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Stopping an RDP Connection
You can stop connections by logging off the Windows  desktop or 
suspend them by disconnecting the session. A suspended connection 
or application continues to uses server resources, so some sites 
discourage disconnecting.

� Logging Off

On the Windows NT desktop, select Start > Logoff to close open 
applications, log off and end the connection.

On the Windows 2000 desktop, select Start > Shut Down > Logoff 
to close open applications, log off and end the connection.

� Disconnecting

On the Windows NT desktop, select Start > Disconnect to log off 
and end the connection, but leave applications running in a 
suspended state. When you reconnect to the server, the 
applications are in the same state as when you disconnected. It 
may be convenient to disconnect, but applications left running 
may place excessive demands on the server.

On the Windows 2000 desktop, select Start > Shut Down > 
Disconnect to log off and end the connection, but leave 
applications running in a suspended state.

ICA Connections
The Citrix ICA client provides both network and dial-in connections 
using the ICA protocol. It does not support modem callback.

You can run two types of ICA sessions: Citrix server connections and 
published applications. 

� Citrix server connections allow you to connect to the Windows 
desktop of a specific Citrix server; you can run any applications 
available on the desktop, in any order.

� Published applications are specific applications set up by an 
administrator for remote users to run. When connected, you are 
presented with the application itself.
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The connection wizard asks for information necessary to create a 
connection. The screens it displays vary somewhat depending on the 
version and build of the Citrix ICA client. This section describes the 
Citrix ICA client, version 6.0. Previous versions of the Citrix ICA 
client are available on some NCD ThinSTAR terminals.

You can check the version in Terminal Properties. To go to Terminal 
Properties from the Connection Manager, press F2. To check the 
version, select Inventory > Software > Installed Software and find 
Citrix ICA.

Adding and Configuring an ICA Network Connection
To add and configure an ICA network connection:

1. Press Ctrl+Alt+End to display the Connection Manager. 

2. From the Connection Manager, select the Configure tab and click 
Add. The connection wizard displays.

3. Select the Citrix ICA client as the type of connection.

4. Select Network Connection as the connection type and click 
Next.

5. Select a server or published application and click Next.

The lists displayed depend on the global ICA client settings in 
Terminal Properties, as described in Configuring Global ICA 
Client Settings on page 83. By default, they include servers or 
published applications in the local network.

The client uses the primary Citrix server to build the lists. To 
build the first list, it does an auto-locate broadcast and uses the 
first ICA server browser that responds. If servers or published 
applications do not appear and you think they should, click 
Refresh to update the lists. For example, you may need to refresh 
the lists in the following situations:

— A server or published application does not appear because 
the network had a temporary problem or a server was down.

— You have just added or removed servers.
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— You have just added a server on another subnet in one of the 
server locations.

Addresses on Remote Networks

To list servers and published applications on remote networks, 
click Server Location and edit the list.

Remote Application Manager uses the information entered in the 
Server Location screen to help locate available Citrix servers and 
published applications.

If you are on another network (for example, if you are on the 
other side of a router, across the Internet, or connected by RAS), 
click Add to enter the IP address or DNS name of a Citrix server 
on the network that contains the Citrix server you would like to 
connect to. The ICA client uses this server to locate the list of 
available Citrix servers on the network.

If your network configuration cannot propagate UDP traffic (for 
example, if your firewall restricts UDP broadcasts), click Use 
HTTP Server location. Make sure that the list contains the IP 
address or name of a Citrix server running the Citrix XML 
service on the network that contains the Citrix server you would 
like to connect to.

The ICA client uses this server to locate the list of available Citrix 
servers on the network.

— Server Group

If your screen includes a Server Group option, you locate 
available servers and published applications by group. This 
selection is used instead of a group defined in global settings 
for the Citrix ICA client in Terminal Properties.

You can define up to three groups of Citrix servers to which 
you want to contact a primary and two backups. The client 
attempts to contact all the servers within the Primary group 
using directed packets; the first server to respond is then 
queried for the address of the master ICA Browser. If none of 
the servers respond, the client attempts to contact all the 
servers within the Backup 1 group. If there is still no 
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response, the client attempts to contact all of the servers in 
the Backup 2 group. This process is repeated each time the 
user attempts to make an ICA connection.

— Addresses

The default address, Auto-Locate, lists servers and published 
applications on the local network only.

You can use the following buttons to edit the list:

6. Specify a title for the connection. 

By default, the server or published application name is 
displayed. To specify a different title, backspace through the 
default name and type another name.

7. Choose what to display when the connection starts, then click 
Next.

To start with the Windows desktop, leave this information blank.

To start with an application, enter the following information:

— Command Line

Enter the path and name of the application. During the 
session, you can run only this application. When you quit the 
application, the session ends.

— Working Directory

Enter the drive and path of the working directory (optional).

Add To include servers and published applications on 
remote networks, such as those on the other side of 
a gateway, click Add. Enter the name or IP address 
of a server that tracks servers on the remote 
network. ICA browsing is not supported in dial-up 
mode.

Delete To delete a server from the list, select it and click 
Delete.

Default List The list saved last is the default list. To replace the 
current list with the default list, click Default List, 
then click Yes.
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This associates the directory with the application; when you 
access a file from the application, the application uses the 
working directory by default. For example, commands in the 
application’s File menu operate, by default, on files in the 
working directory.

8. Specify logon information, then click Next.

If you enter a valid user name, password, and server domain, it 
is used for an automatic logon.

If you leave any of these fields blank, the connection prompts for 
all of the information.

For published applications, the logon information must be valid 
for the server running the published application. If the 
connection is to an anonymous published application, the logon 
information is ignored.

9. Select the number of colors to be displayed. If you select 
Thousands, be sure that HighColor has been enabled for the 
desktop or application and that the proper version of Metaframe 
has been installed. Click Next.

A dial-up connection may be faster with 16 colors.

The default number of colors displayed is affected by the global 
ICA client settings you can make in Terminal Properties. For 
more information, see Configuring Global ICA Client Settings on 
page 83.

Note To verify that HighColor is enabled for the desktop, check 
the setting on the Display tab in Terminal Properties. See 
Display Properties on page 30 for additional information.

10. Specify compression and sound, then click Next.

Provide information as follows:

— Use Printer Configuration Utility

When this option is enabled, the client can use the printer 
configuration utility on the Citrix server. If a printer has been 
defined in Terminal Properties, it is mapped to the client. See 
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Configuring an RDP Printer in Terminal Properties on page 
73. 

Disable this option if you want to connect to MetaFrame for 
Window 1.8 servers where you can map printers manually. 
See Mapping Client Printers on MetaFrame for Windows and 
WINFRAME on page 91 for details.

— Compress Data Stream

Enable or disable data compression. Enabling compression 
reduces the amount of data transferred between the terminal 
and server but increase the load on the server.

Disabling compression reduces the load on the server but 
transfers more data. With a high speed LAN, compression 
may be unnecessary.

— Enable Sound 

Allows applications to play sound on the terminal.

— Sound Quality

If sound is enabled, set sound quality. The higher the quality 
level, the greater the bandwidth consumption.

Medium is recommended for LAN-based connections.

Low is recommended for low-bandwidth connections, 
including modem connections.

— Speed Screen

Speed Screen Latency reduction enhances the session on 
slower networks. This option is available only when you are 
connected to a Citrix server where it is both supported and 
enabled.

— Encryption Level

Encryption increases the security of your ICA connection. By 
default, basic encryption is enabled on all connections. If the 
Citrix server you are connecting to supports advanced 
encryption (e.g., SecureICA Services) you can set a higher 
level of encryption.
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11. Enter firewall information.

If you are using a SOCKS proxy server to limit access to Citrix 
servers, you must configure the ICA Client to connect to Citrix 
servers through a SOCKS proxy server. You can configure a 
default SOCKS proxy for all connections or use only a SOCKS 
proxy with a specific connection file.

To configure a default SOCKS proxy server, select Connect via 
SOCKS proxy and enter the SOCKS proxy server’s IP address 
and the proxy server’s port number (if it is not 1080).

Note If you configure a default SOCKS proxy server, you can 
successfully browse for a server or published application 
only if you specify at least one server.

If the terminal is outside a firewall that uses address remapping, 
you must configure the ICA Client to use the alternate address 
returned by the master ICA Browser. This is necessary even if 
you are not using a SOCKS proxy server.

Note You must use the ALTADDR utility to manually set the 
alternate address for each Citrix server. For information, 
see the Command Reference appendix of your 
MetaFrame Administrator’s Guide or the WINFRAME 
System Guide.

Note If you set alternate address translation for all connection 
entries, it cannot be disabled for specific connection 
entries.

12. Click Finish to save the connection.

Adding an ICA Dial-In Connection
For a connection over a modem, you can add an ICA dial-in 
connection.

This requires configuring the ICA dial-in server. See the WinFrame/
MetaFrame documentation for instructions.

The NCD dial-up client provides an alternative way of adding a 
connection over a modem. To use this method, identify the ICA 
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connection as a network connection and set dial-up options as 
described in NCD Dial-Up Connections on page 97.

To create an ICA dial-in connection:

1. Start the connection wizard.

If the Citrix ICA client is the default client, its connection wizard 
starts after you set up the terminal so that you can define one 
connection.

2. After adding the first connection, you can press Ctrl+Alt +End to 
display the Connection Manager, then start the wizard from it. 

To start the wizard, select the Configure tab, click Add. Select the 
Citrix ICA client as the type of connection.

3. Select Dial-In Connection as the connection type and click Next.

4. Provide modem information as follows, then click Next.

— Dial-In Device

Modem type. Hayes Compatible is the only type supported.

— Phone Number

The full phone number (long distance access, country code, 
area code, and phone number), with or without hyphens.

Click Configure if you want to configure port settings and call 
options (see Step 4 on page 99 on page 99 for definitions).

5. Complete the remaining screens. These screens are the same as 
those for a network connection; explanations for completing 
them begin with Step 6 on page 79 on page 79.

Configuring Global ICA Client Settings
In Terminal Properties, you can define default settings for all ICA 
client connections. You can override some of these settings when you 
create an ICA connection.

The Global ICA Client Settings dialog box contains the following 
tabs:
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� The Default Hotkeys tab, where you can define alternative key 
combinations for system hotkeys. See Hotkeys on page 84 for 
additional information.

� The Preferences tab, where you can control the default window 
and settings used for new connection entries. See Preferences on 
page 85 for additional information.

� The Server Location tab, where you can configure Business 
Recovery options. See Server Location on page 86 for additional 
information.

� The Firewall Settings tab, where you can configure the client to 
use a SOCKS proxy and alternate address remapping. See 
Firewall Settings on page 87 for additional information.

� The PNLite tab, where you can enable and configure PNLite 
mode. In PNLite mode, a list of available published applications 
on the network is pushed to the ICA client and displayed in the 
Connection Manager dialog box. This means the user need not 
configure each connection entry manually. See PNLite Mode on 
page 88 for additional information.

To set global settings for the ICA client:

1. From the Connection Manager, press F2 to start Terminal 
Properties.

2. Select Management > Clients.

3. Select the Citrix ICA client beside the Configure Client button, 
then click the button.

4. Make global ICA client settings on any or all of the following 
tabs, then click OK to save your changes or click X to cancel 
them: Hotkeys, Preferences, Server Location, Firewall Settings, 
PNLite.

Hotkeys

The Citrix ICA client provides hotkeys for basic functions. These 
affect the ICA client or emulate standard Windows sequences.
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Preferences

Provide data as follows.

— Serial Number

Leave this empty.

— Default Window Colors

Check 16, 256, or Thousands colors if HighColor is enabled. 
Low-bandwidth connections, such as most modem 
connections, may perform better with 16 colors.

Default Values for the ICA Client Hotkeys

Function Default Description

Status Ctrl+6 Displays the status of the connection.

Close 
application

Ctrl+2 Disconnects the ICA client from the server and closes the 
client window, but the session still runs on the server. To avoid 
this, log off instead of using the hotkey.

Toggle title bar Ctrl+3 Hides or displays the window title bar.

Ctrl+Alt+Del Ctrl+4 Sends the standard Windows Ctrl+Alt+Del to the server. 
Displays the Windows Security information.

Ctrl+Esc Ctrl+5 Sends the standard Windows Ctrl+Esc to the server. The 
remote Task List appears on WinFrame servers; the Windows 
Start menu appears on MetaFrame servers.

Alt+Esc Ctrl+7 Sends the standard Windows Alt+Esc. Cycles through 
minimized icons and open application windows.

Alt+Tab Ctrl+8 Sends the standard Windows Alt+Tab to the server. Cycles 
through open applications, displaying programs.

Alt+Backtab Ctrtl+9 Cycles through open applications in reverse order.
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— Client Name

The terminal name used when a printer is attached to the 
terminal during an ICA session. For details, see Configuring 
ICA Access to Printers on page 90.

Server Location

The ICA client uses this data to locate servers and published 
applications when you create or edit an ICA connection.

— use HTTP server location

Uses the HTTP protocol to build a server list across subnets.

— Server Group

If your screen has a Server Group option, a group you select 
here is used instead of a group defined in global settings for 
the Citrix ICA client in Terminal Properties.

You can define up to three groups of servers—one primary 
and two backups. When an ICA connection starts, the client 
tries to contact servers in the Primary group; if a server 
responds, it asks for the address of the master ICA Browser. If 
not, the client tries to contact the servers in Backup 1, and, if 
necessary, the servers in Backup 2.

— Addresses

Auto-Locate, the default, causes the client to seek only 
servers and published applications on the local network. You 
can use the following buttons to edit the list:

Add To include servers and published applications on a 
remote network, click Add. Give the name or IP 
address of a server that tracks servers on the remote 
network and click OK. ICA browsing isn’t supported 
for dial-up.

Delete To delete a server from the list, select it and click 
Delete.

Default List The list saved last is the default list. To replace the 
current list with the default list, click Default List, 
then click Yes.
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— Rename Groups

You can change group names.

Firewall Settings

You can make global firewall settings.

If you are using a SOCKS proxy server to limit server access, you 
must configure the ICA Client to connect to Citrix servers 
through a SOCKS proxy server. You can configure a default 
SOCKS proxy for all connections or use only a SOCKS proxy 
with a specific connection file.

To configure a default SOCKS proxy server, select Connect via 
SOCKS proxy and enter the SOCKS proxy server’s IP address 
and the proxy server’s port number (if it is not 1080).

Note If you configure a default SOCKS proxy server, you can 
successfully browse for a server or published application 
only if you specify at least one server in Step 5 on page 77.

If the terminal is outside a firewall that uses address remapping, 
you must configure the ICA Client to use the alternate address 
returned by the master ICA Browser. This is necessary even if 
you are not using a SOCKS proxy server.

Note You must use the ALTADDR utility to manually set the 
alternate address for each Citrix server. For information, 
see the Command Reference appendix of your 
MetaFrame Administrator’s Guide or the WINFRAME 
System Guide.
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Note If you set alternate address translation for all connection 
entries, it cannot be disabled for specific connection 
entries.

PNLite Mode

PNLite is an ICA connection mode that enables the CE client to 
connect to applications available on a Citrix server without 
having to configure connections for each published application.

1. Check the Enable PNLite checkbox.

2. Enter the address and port number of the Citrix XML server 
in the Address and port of NFuse server field.

3. Enter your user name, password, and domain in the 
appropriate User Credentials edit fields. Check the Save 
Password box if you want the terminal to remember your 
password.

The list of available applications will now be displayed in the 
Connection Manager dialog box.

Starting an ICA Connection
You start connections from the Connection Manager, which lists all 
connections on its Connections tab. If the Connection Manager is not 
displayed, press Ctrl+Alt+End.

A terminal must be in the correct mode—LAN or dial-up—to start a 
connection. To change the mode, see the Network Connection Type 
on page 49.

1. In the Connection Manager, select the Connections tab, then 
double click the connection or select the connection and click 
Connect.
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If the connection was correctly defined and the server is running, 
the connection starts.

If the terminal cannot connect, select the Configure tab. Correct 
the server specification for the connection if it is wrong, then try 
to connect again. If you have the right server, see whether it is 
running and check whether the terminal is physically connected 
to the network. For more information, see Test Network 
Connections on page 51.

2. Enter logon information—user name, password, and domain—if 
requested. A connection may need a manual logon or the user 
information in an automatic logon connection may be wrong or 
may not be authenticated for that server.

The connection starts the specified application or the server’s 
desktop, depending on startup options set when it was defined.
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Stopping an ICA Connection
You can log off or disconnect ICA connections. Disconnecting 
suspends the connection and leaves it executing on the server; you 
can reconnect later and resume any tasks left running. Since the 
connection continues to use server resources even if disconnected, it 
may be better to log off.

Logging Off

On WinFrame servers, in the Program Manager, select File > Logoff.

On MetaFrame servers, select Start >Logoff.

On MetaFrame Windows 2000 servers select Start > Shutdown > 
Logoff.

Disconnecting

On WinFrame servers, in the Program Manager, select File > 
Disconnect.

On MetaFrame servers, select Start >Disconnect.

On MetaFrame Windows 2000 servers select Start > Shutdown > 
Disconnect.

Configuring ICA Access to Printers
During a Citrix ICA session, a user can print to a printer attached to 
the serial or parallel port of an NCD ThinSTAR terminal if the server 
allows client printer mapping and the printer is mapped as 
explained in the following sections.

It is possible to print to local printers during connections to servers 
or published applications. In an application’s print command, the 
user selects the local mapped printer from the list of printers.
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To map a local printer, you must associate a client name to the 
terminal. You can change the name on the Preferences tab of Global 
ICA Client Settings. The default name is the terminal’s serial 
number.

Note You must configure every Windows server needed for 
printing. 

Mapping Client Printers on MetaFrame for Windows and 
WINFRAME

To manually map a client printer on a MetaFrame 1.8 or 
WINFRAME 1.8 server:

1. Log on to the Citrix server.

2. On a MetaFrame server, click Start, Programs, MetaFrame Tools, 
and then ICA Client Printer Configuration.

-or-

On a WINFRAME server, double-click ICA Client Printer 
Configuration in the Administrative Tools program group of 
Program Manager.

3. On the Printer menu, click New to display the Add ICA Client 
Printer wizard. Follow the steps in the wizard to map the client 
printer.

Note If you are using a CDS installation, you need to select the Use 
Printer Configuration Utility setting in the Options tab on the 
Connection Details dialog. To bring up the Connection 
Details dialog, in the Connection Manager, select the 
Configure tab, select the ICA Connection and click Edit.

To manually map a client printer on a MetaFrame 1.0 server:

1. Log on to the MetaFrame server.

2. In the ICA session window, double-click My Computer and then 
double-click Printers.
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3. Double-click Add Printer. Select Network printer server and 
click Next.

4. In the Shared Printers box, double-click Client Network and then 
double-click Client.

5. Select clientname#port, where clientname is the name you 
assigned to your terminal and port is the printer port on your 
terminal, and then click OK.

6. If you want this printer to be your default printer, click Yes.

7. Click Next and then click Finish.

Note If you are using a CDS installation, you need to also deselect 
the Use Printer Configuration Utility setting in the Options 
tab on the Connection Details dialog to use the mapped 
printer. To bring up the Connection Details dialog, in the 
Connection Manager, select the Configure tab, select the ICA 
Connection and click Edit.

To manually map a client printer on a WlNFRAME 1.7 server:

1. Log on to the WINFRAME server.

2. In the ICA session window, double-click Print Manager in the 
Main program group of Program Manager.

3. On the Printer menu, click Create Printer.

4. In the Shared Printer list, double-click Client.

5. Double-click the required printer.

Note If you are using a CDS installation, you need to also deselect 
the Use Printer Configuration Utility setting in the Options 
tab on the Connection Details dialog to use the mapped 
printer. To bring up the Connection Details dialog, in the 
Connection Manager, select the Configure tab, select the ICA 
Connection and click Edit.

To view mapped client printers when connected to a MetaFrame 
for Windows server:

While connected to a MetaFrame for Window server, double-click 
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My Computer on the remote desktop and then double-click Printers. 
The Printers dialog box appears. 

The Printers dialog box displays the mapped local printers along 
with any other printers available on the MetaFrame for Windows 
server. The name of the printer is clientname#port, where clientname 
is the name you have assigned to your ICA Client and port is the 
printer port on your terminal, for example COMl or LPTl.

To view mapped client printers when connected to a WlNFRAME 
server:

While connected to the WINFRAME server, double-click Print 
Manager in the Main program group of Program Manager. Print 
Manager displays the local printers mapped to the ICA session.

The name of the printer is clientname#port, where clientname is the 
name you assigned to your terminal and port is the printer port on 
your terminal.

Mapping Client Printers on MetaFrame for UNIX

Before users can print to a client printer from MetaFrame for UNIX, 
printing must be enabled by the administrator. This section describes 
how to enable printing on the server. It describes how users can list 
available client printers and print files from the command line or 
from applications.

In a UNIX environment, the application performs the print 
rendering. The printer driver is specified inside the application or, in 
the case of a desktop utility, raw text is generated.

Note For further information about printing on MetaFrame for 
UNIX Operating Systems, see the MetaFrame 1.1 for Solaris 
Administrator's Guide and the manual pages.
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Setting up Printing

To check if client printing is currently enabled or disabled:

1. Log on to the MetaFrame server as a Citrix server administrator.

2. At the command prompt, type:

ctxcfg -p list

To enable or disable client printing:

Log on to the MetaFrame server as a Citrix server administrator. At 
the command prompt:

To display mapped client printers:

At the command prompt, type:

ctxprinters

A list of printers configured on the client and mapped for use from 
the ICA session is displayed. (default) is displayed after the printer 
that is the default. The following information is shown for each 
printer:

� Printer name or printer port (for example, LPTl). This can be 
used in the ctxlpr -p command to specify a printer other than the 
default.

� Printer driver name. This is for information only.

� Printer connection description. This is for information only.

Using Printing

To print a file from an ICA Client session:

1. At the command prompt, type ctxprinters.

To Use the Command

Enable client printing ctxcfg -p enable
Disable client printing ctxcfg -p disable
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2. From the results of ctxprinters, identify the printer or printer port 
that you want to use. To print to a printer other than the default, 
note the printer name; the printer name is the first item in the 
ctxprinters listing.

3. At the command prompt:

To print from applications

The exact configuration of how to set up printing from applications 
depends on the behavior and user interface of the UNIX application.

If the user interface for an application allows you to specify the 
actual printer command to use when printing, you can configure 
client printing by replacing the lpr or lp command with the ctxlpr 
command.

When a user connects to the server and prints from the application in 
a session, the server redirects the output to the mapped client 
printer. 

Often, in this type of application, you can also specify the command 

To Use the Command

Print the file named filename to the default 
printer

ctxlpr filename

To Use the Command

Print a series of files to the default printer. 
Each file is treated as a separate print job.

ctxlpr filename filename

Print a file to a printer (or printer port) other 
than the default. This is the printer name of 
printer port shown in the first column of the 
output from ctxprinters.

ctxlpr -P [Printername | 
Printerport] filename

Print a file in the background. ctxlpr -b filename
Print a file only if the printer is not in use. 
Use this option to stop an application 
waiting while other printer jobs are handled. 
If the printer is in use, an error message is 
displayed.

ctxlpr -n filename
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line modifiers on a different line. You can use the same switches for 
ctxlpr as when printing from the command line. For example, use -P 
with a printer name (or printer port) to print to a printer other than 
the default; use -b for background printing, and so on.

Note If the user interface of an application does not allow you to 
specify the actual printer command to use when printing, 
determine if the application (or window manager) uses a 
configuration file where you can replace the lpr command 
functionality with ctxlpr. 

Configuring ICA for MetaFrame for UNIX
For connections to applications published on a MetaFrame for UNIX, 
two additional utilities provide functionality for configuring session 
display, and copying and pasting objects between the ICA session 
and the client device. This section describes how to access and use 
these tools through the Citrix window manager.

Using the Window Manager

If you are connecting to an application published on a MetaFrame 
for UNIX server, use the Citrix window manager (ctxwm) to 
minimize, resize, position, and close windows. This section describes 
how to use the window manager.

Minimizing, Resizing, Positioning and Closing Windows

When you connect to a published application on a MetaFrame for 
UNIX server, buttons to minimize, resize, position, and close 
windows are provided by the Citrix window manager.

Using the Citrix Window Manager Menus

In remote desktop windows, you can use the ctxwm menu system to 
log off, disconnect, and exit from published applications and 
connection sessions.
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To access the ctxwm menu system:

1. On a blank area of the remote desktop window, click and hold 
down the left mouse button. The ctxwm menu is displayed.

2. Drag the mouse pointer over Shutdown to display the shutdown 
options.

To choose an option from the Citrix window manager menu:

Drag the pointer over the required option to highlight it. Release the 
mouse button to select the option.

Note Your Citrix server may be configured to terminate any 
applications that are running if a session is disconnected.

NCD Dial-Up Connections
The dial-up client provides a network connection over a modem. 
Once the connection is established, a protocol client connection 
(RDP, for example) can start. Therefore, you must configure both a 
dial-up connection and a connection for an RDP client, ICA client, or 
an optional installed protocol client.

After you complete the Setup Wizard, the terminal starts the 
appropriate connection wizard (RDP or ICA) if no connection exists. 
It then starts the NCD dial-up connection wizard.

Note The NCD dial-up client does not support modem callback.

If you want to connect to an ICA session over a modem you have 
two choices:

� You can create an ICA dial-in connection as described in Adding 
an ICA Dial-In Connection on page 82.

To Choose

Terminate the connection and all running applications. Logoff
Disconnect the session but leave the application running. Disconnect
Disconnect the session and terminate the application. Exit
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� You can create an NCD dial-up connection, then create an ICA 
network connection to use over the dial-up line.

Adding an NCD Dial-Up Connection
This section explains how to create an NCD dial-up connection.

To add an NCD dial-up connection using the NCD dial-up client:

1. Start the connection wizard.

If you select the dial-up client as the default when configuring 
the terminal, the dial-up connection wizard starts after you 
create an RDP or ICA connection so you can configure the dial-
up connection.

If connections exist and you want to add more, go to the 
Configure tab of the Connection Manager and click Add, then 
select the NCD dial-up client.

2. Specify the connection name and click Next.

The name could identify the host or the application. It can have 
up to 20 characters when you are defining the connection. If you 
edit the connection from the Connection Manager, the name can 
be extended to 32 characters.
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3. Select a modem.

Currently, only Hayes-compatible modems are supported.

4. Click Configure to configure the port settings and call options.

Provide information for Port Settings as follows.

— Manual Dial

If this is enabled, the user can enter data and modem 
commands in a separate window when dialing. The manual 
dialing window is provided by the Microsoft Windows RAS/
TAPI subsystem. If manual dialing is disabled, the NCD dial-
up client dials the phone number and no window is 
displayed.

— Terminals

Use terminal window before dialing
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If this is enabled, the user can enter modem commands 
before dialing the host computer.

Use terminal window after dialing

If this is enabled, the user can enter commands to the host 
computer after dialing is complete.

— Connection Preferences

Choose values as follows.

The following serial port parameters (baud rate, data bits, 
parity, and stop bits) determine the characteristics of the 
connection between the terminal and the modem and are 
automatically sensed by the modem. The modem uses these 
parameters to define the format of the data that it sends to the 
host and expects from the host.

Baud Rate—Determines the upper limit of the speed of the 
connection between the modem and the host. Select the 
highest speed available on the terminal’s modem; the modem 
does not negotiate a connection higher than the baud rate 
you specify.

Data Bits—The number of data bits generated by the terminal 
and expected by the host.

Parity—The type of parity generated by the terminal and 
expected by the host.

Stop Bits—The number of stop bits generated by the terminal 
and expected by the host.

Flow Control—The type of flow control handshaking used 
on the terminal’s serial port and expected by the host. You 
can select one of the following:

If you choose Hardware, hardware handshaking, also called 
DTR/DSR, is used.

If you choose Software, the terminal sends an XOFF (^S) 
character when the input buffer space is low and an XON 
(^Q) character when input buffer space is available. This is 
not recommended because noise on the line can introduce 
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spurious XOFF characters that can cause the connection to 
freeze.

If you choose None, there is no flow control handshaking.

Provide information for Call Options as follows.

— Call Setup

Use these options as follows.

Cancel the call if not connected within seconds—This option 
cancels the call if it is not completed within the specified 
time. Set this to the amount of time you are willing to wait for 
the connection to occur.

Wait for dial tone before dialing—When this is enabled, the 
call does not go through until there is a dial tone. Disable this 
if you are making a direct serial connection between two 
modems and not using the phone line. With such a 
connection, there is never a dial tone.

Wait for credit card tone seconds—This option waits for the 
specified time before continuing the call to allow time for 
entering a credit card number.

— Extra Settings

You can enter modem commands here to override the default 
settings; for example, to turn on local echo, enter ‘E1’.
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5. Click TCP/IP Settings to configure TCP/IP. The following dialog 
displays.

Supply information on the General tab as follows:

— Server-assigned address

Select this item if your dial-in host supplies the terminal with 
an IP address. Uncheck this box and fill in the IP address field 
if the host does not supply an IP address. You may want to 
assign an address (if allowed by the server) for long-term, 
dedicated dial-up connections.

— Use SLIP

Enable this option if the dial-up server does not support the 
default protocol, PPP.

— Use software compression

Compression speeds up data transmission; however, it can 
only be used if the terminal and the host use compatible 
compression methods. It should not be necessary to disable 
this option.

— Use IP header compression

Compression speeds up data transmission; however, it can 
only be used if the terminal and the host use compatible 
compression methods. It should not be necessary to disable 
this option.
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Supply information on the Name Servers tab as follows:

— Server-assigned addresses

Causes the dial-up client to accept from the dial-in server the 
IP addresses of the hosts providing name service.

Select this option if your dial-in host gives the terminal name 
resolution parameters. Disable this option and enter the DNS 
and/or WINS name server host addresses if the PPP host 
does not give name server information or if you want to use 
different name server hosts.

— Primary and Secondary DNS

The IP address of the first DNS server to resolve device 
names and the IP address of the DNS server to resolve device 
names if the primary server cannot.

— Primary and Secondary WINS

The IP address of the first WINS server to resolve device 
names and the IP address of the WINS server to resolve 
device names routed if the primary server cannot.

6. Click Next.
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7. Specify the telephone number to dial and click Next.

Type the complete phone number of the modem on the dial-in 
server; using up to 128 characters. For example:

9-1-650-555-1212

Note Hyphens are not required. Remove them, if necessary, to 
remain within the 128-character limit.

Selecting a Startup Session for an NCD Dial-Up Connection
A connection can start automatically once the dial-up network 
connection is established. The list shows your protocol connections 
(RDP or ICA). If no protocol session is selected, selection occurs after 
the dial-up connection is started from the Connection Manager.

To specify the protocol connection to start and other options:

1. Select a protocol connection or <none>.
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2. To automatically close the dial-up connection when the user logs 
off or disconnects from the protocol session, enable Close dial-up 
connection at session end. Otherwise, the dial-up connection 
remains open and the user can select another protocol session. 

3. To erase the saved user name and password, click Forget 
Password.

When the connection is first created, this option is not available. 
The user can enable it by saving the user name and password 
after starting the connection. For more information about saving 
the user name and password, see Starting an NCD Dial-Up 
Connection on page 105. Depending on your environment, 
saving the password may be an unacceptable security risk.

4. Click Next.

5. To review or change settings, click Back. To apply the settings, 
click Finish. The new connection is included in the list of 
connections in the Connection Manager.

Starting an NCD Dial-Up Connection
The terminal must be in dial-up mode as described in Network 
Connection Type on page 49.

To start a dial-up connection, using the NCD dial-up client:

1. Press Ctrl+Alt+End to display the Connection Manager.

2. On the Connections tab of the Connection Manager, double click 
the connection name or select the connection and click Connect.

If the connection was correctly defined, and the server is 
running, the connection starts.

If the terminal cannot connect, select the Configure tab. Correct 
the dialing specification for the connection if it is wrong, then try 
to connect again.
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3. The first time you use a dial-up connection, you must log in. 
Click Save Password if you do not want to enter it the next time 
you start the connection.

Note If saving the password introduces an unacceptable 
security risk, you can edit the dial-up connection and 
enable Forget Password. See Step 3 of Selecting a Startup 
Session for an NCD Dial-Up Connection on page 104 for 
more information.

4. Begin a protocol connection session.

If a startup session is defined for the connection, it starts 
automatically.

If none is defined, press Ctrl+Alt+End to display the Connection 
Manager, select a protocol connection, and click Connect.

5. Enter logon information—user name, password, and domain—if 
requested.

A connection may require logging on manually or the user 
information in an automatic logon connection may be wrong or 
may not be authenticated for that server.

The connection starts the specified application or the server’s 
desktop, depending on startup options.

Stopping an NCD Dial-Up Connection
How you stop the dial-up connection depends on how it is 
configured.

Configuration Setup How you stop

Close dial-up connection at 
session end is enabled.

Log off or disconnect from the application host. The 
connection stops automatically, then the dial-up 
session ends.
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Microsoft Internet Explorer Browser

Configuring Internet Explorer
To allow an Internet Explorer session on a terminal:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Extensions and then double-click IE Browser.

3. Click Enable Web Connection. Once selected, a Web connection 
appears in the NCD ThinSTAR Connection Manager. Only one 
Web connection per terminal is allowed.

Note This is the only mandatory browser configuration item. 
Changing other browser configuration items is optional.

4. Change browser preferences as appropriate. See Browser 
Options on page 57 for explanations of available options.

Note To delete the web connection from the Connection Manager, 
deselect the Enable Web Connection checkbox.

Starting Internet Explorer
Be sure that you have configured the browser in the Terminal 
Properties Extension tab. Once you have configured the browser, a 
Web connection appears in the NCD ThinSTAR Connection 
Manager. To start the browser, double-click the Web connection.

Close dial-up connection at 
session end is disabled or 
no startup session was 
selected.

Log off or disconnect from the application host, then 
click Disconnect to stop the dial-up connection when 
prompted.

You can also highlight the active dial-up session in the 
Connection Manager and click End.

Configuration Setup How you stop
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Stopping Internet Explorer
To end your browser session, press Control+Alt+End and then click 
End in the NCD ThinSTAR Connection Manager. 

Managing Connections
The Configure tab of the Connection Manager has options for 
performing the following functions:

� Adding connections

� Editing connections

� Deleting connections

� Stopping connections

� Setting a connection as the default or setting it to start 
automatically

The Connection Manager is on the terminal screen when no 
connection is running. To display it when a connection is running, 
press Ctrl+Alt+End.

The Configure tab is available, making it easy to set up connections 
on a terminal. After you have created connections, you can hide the 
Configure tab to preserve the connections. Instructions are on page 
53.

Adding a Connection in the Connection Manager
After you have created one connection as part of the startup process, 
you can use the Connection Manager to create new connections.
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To add connections:

1. On the Configure tab of the Connection Manager, click Add.

2. Select the type of connection. The list includes optional clients 
that you have installed.

3. If the client software provides a wizard or utility for defining a 
new connection, it starts now.

For the Microsoft Terminal Server client, see page 71. For the 
Citrix ICA client, see page 76. For an NCD dial-up client, see 
page 96. For Internet Explorer connections, see page 56.

Editing a Connection in the Connection Manager
To modify the properties of a connection:

1. On the Configure tab of the Connection Manager, select the 
desired connection.
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2. Click Edit and make changes.

Edit mode and the connection wizard may present information 
differently. For example, properties for an RDP connection 
appear as follows:

Refer to the following pages for an explanation of the 
information presented: Microsoft Terminal Server on page 71; 
Citrix ICA on page 76; NCD dial-up on page 96; Internet 
Explorer on page 56.

Deleting a Connection in the Connection Manager
To delete an existing connection:

1. On the Configure tab of the Connection Manager, select the 
connection you want to delete.

2. Click Delete and confirm that you want to delete the connection.

To delete a Web Connection:



NCD ThinSTAR Terminal User’s Guide 111

Managing Connections

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Extensions and then double-click IE Browser.

3. Deselect the Enable Web Connection checkbox. Once deselected, 
a Web connection does not appear in the NCD ThinSTAR 
Connection Manager. 

Stopping a Connection from the Connection Manager
It is best to disconnect or log off from the host desktop or 
application, but you can also stop a connection from the Connection 
Manager.

Note To disconnect or log off, see Stopping an RDP Connection on 
page 76, Stopping an ICA Connection on page 90, Stopping 
an NCD Dial-Up Connection on page 106 or Configuring 
Internet Explorer on page 56.

1. Select the Connections tab of the Connection Manager.

2. Select the active connection and click End, then click OK when 
prompted to confirm that you want to disconnect.

The connection that is 
running has active 
status.

The End button 
disconnects (suspends) 
connections, but may 
leave them running on 
the server, using 
resources. For this 
reason, administrators 
often prefer to have 
users log off.
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If you do not respond or have a problem with the session, click 
End Task when prompted to terminate immediately.

Setting Startup Options in the Connection Manager
You can select one connection as the default connection or as an 
autostart connection.

Setting a Default Connection

The default connection is the one highlighted when you display the 
Connection Manager. You can start the default connection, or switch 
to it, by pressing Ctrl+Alt+Home. One connection can be the default 
connection. If you set a connection as an autostart connection, it 
automatically becomes the default.

To set a connection as the default:

1. On the Configure tab of the Connection Manager, select the 
connection you want to have as the default and click Startup.

2. Select Make the selected connection your default connection.
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Setting the IE Browser as the Default Connection

To make the IE browser your default connection:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Extensions and then double-click IE Browser.

3. Select the Enable Web Connection checkbox. Once selected, a 
Web connection appears in the NCD ThinSTAR Connection 
Manager. Only one web connection per terminal is allowed.

4. Double-click Configure Startup and select the Make the Web 
Connection your default connection checkbox.

Setting an Autostart Connection

You can configure a connection to start automatically when you 
restart the terminal.
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When you log off, the autostart connection restarts immediately. If 
this happens and you want to stop it, see Stopping an Autostart 
Connection on page 116.

A dial-up connection must specify a protocol connection as well for 
true automated startup, or it is necessary to start the protocol 
connection manually at logon.

Configuring a connection to start automatically makes it the default 
connection. If you later make another connection the default, the 
original autostart connection no longer starts automatically.

To configure a connection to start automatically:

1. On the Configure tab of the Connection Manager, select the 
connection you want to start automatically.

2. Click Startup, then select Automatically start the selected 
connection at startup.
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The autostart connection fails unless it corresponds to the 
terminal’s network connection mode—LAN or dial-up. If you 
need to change the mode, see Network Connection Type on page 
49.

Setting the IE Browser as an Autostart Connection

To configure the IE browser as an Autostart Connection:

1. From the NCD ThinSTAR Connection Manager, press F2 to enter 
Terminal Properties.

2. Select Extensions and then double-click IE Browser.

3. Select the Enable Web Connection checkbox.

4. Double-click Configure Startup. In the Web Connection Startup 
dialog, select the Make the Web connection your default 
connection checkbox.
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5. Select the Automatically start the Web connection at startup 
checkbox.

Stopping an Autostart Connection

An autostart connection restarts as soon as you close the Windows 
desktop or log off. To prevent this, set the connection as the default 
connection rather than the autostart connection.

To stop the autostart connection:

1. While the autostart connection is active, press Ctrl+Alt+End to 
go to the Connection Manager.

2. Select the Configure tab.

3. Click Startup.

4. Select Make the selected connection your default connection.
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5. To return to your running connection, select the Connections tab 
and select the active connection.

6. Click Connect.
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Navigation Paths and Special Key 
Sequences

After initial setup, which involves setup and connection wizards, the 
Connection Manager and Terminal Properties are the main tools you 
use to administer NCD ThinSTAR terminals. This section 
summarizes movement between tools and use of special key 
sequences.

Navigation Paths
In the Connection Manager, press F2 to go to Terminal Properties.

In Terminal Properties, you can click OK to save and close Terminal 
Properties and return to the Connection Manager, or click Cancel to 
return to the Connection Manager without saving changes.

When you are in a communication session, you can log off, 
disconnect, or press Ctrl+Alt+End to display the Connection 
Manager. Pressing Ctrl+Alt+End leaves the connection active on the 
terminal. Disconnecting ends the connection on the terminal but 
leaves the session active on the server.
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Special keys for NCD ThinSTAR terminals are as follows:

Special Key Sequences

Key Sequence When to Press Result

F5 During progress bar The terminal starts in safe boot mode, using 
640 x 480 resolution.

Shift+F5 During progress bar The terminal provides diagnostic tools, 
including hardware tests and ping to check for 
connections. Typically this is not used because 
diagnostics are available in Terminal 
Properties. The path is Management > 
Network > Diagnostics.

Shift+F11 During progress bar The terminal goes into a forced recovery, 
which rebuilds flash memory. This is available 
only if you installed NCD ThinSTAR Operating 
Software on a Management Server.

Session
Connection 

Manager
Terminal 

PropertiesConnect F2

OK — Saves properties and closes

Cancel — Discards changes and closes

Log Off — Closes session on server and terminal

Disconnect — Closes session on terminal and leaves it 
open on server to reconnect later

Ctrl+Alt+End — Leaves session connection active on 
server
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Ctrl+Alt+End When you want to 
start the Connection 
Manager

The terminal displays the Connection Manager 
with a list of configured connections.

F2 When you can see the 
Connection Manager

The terminal displays Terminal Properties so 
you can view or change configuration settings.

Ctrl+Alt+↑ During a session The terminal cycles up through active 
connections in the Connection Manager.

Ctrl+Alt+↓ During a session The terminal cycles down through active 
connections in the Connection Manager.

Ctrl+Alt+Home During a session or 
before the first session 
starts

The terminal goes to the default 
connection.The connection is started if it is not 
already active.

Special Key Sequences (continued)

Key Sequence When to Press Result
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Glossary

 

Boot ROM See NCD ThinSTAR boot software.

client A device or software on a network that accesses 
services, applications, or data provided by a server. See 
also thin client.

connection A communication session between a client device and a 
server by means of a session protocol. An 
NCD ThinSTAR terminal communicates with a 
Terminal Server by means of the RDP protocol or the 
Citrix ICA protocol. You can define any number of 
connections on an NCD ThinSTAR terminal.

DDC Display Data Channel. DDC allows a display monitor 
to inform the host system about its identity and 
communicate additional levels of display capabilities.

DHCP Dynamic Host Configuration Protocol. A network 
service that dynamically assigns valid IP addresses to 
network devices as they start up. DHCP can also 
provide machines with valid subnet mask values, the 
IP addresses of gateway devices, DNS servers, and 
WINS server IDs. See also subnet mask and DNS.

DNS Domain Name System. A distributed database and 
utilities for defining TCP/IP domains and mapping 
domain names to IP addresses. See also domain and 
fully qualified domain name.
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domain A set of network devices that are managed together. 
NCD networking involves DNS domains and 
Windows domains.

A DNS domain is a TCP/IP construct that defines 
hierarchical groups of devices on the Internet. It is a 
segment of the Internet and is given a unique, official 
name by InterNIC, the organization that administers 
Internet names and IP addresses.

A Microsoft Windows domain is a unique group of 
Windows Servers and workstations that the network 
administrator defines for centralized administration.

See also domain controller, DNS, and fully qualified 
domain name.

domain controller A Windows  server maintains the master database for a 
Microsoft domain (see domain). The database identifies 
users and systems, both of which may be members of 
the domain. The domain controller authenticates 
domain logons and maintains the Windows  domain’s 
security policy.

fully qualified domain 
name

A name for a network device that combines its 
hostname and its DNS domain name. For example, 
suppose that the domain acctg.biggcorp.com has a 
device whose hostname is SaleServer. The device’s 
fully qualified domain name is 
SaleServer.acctg.biggcorp.com. See also DNS and 
domain.

FQDN See fully qualified domain name.

HighColor Provides 16-bit color for those sessions that support it. 
Both ICA and Microsoft Internet Explorer support 
HighColor. 

ICA Independent Computing Architecture. A remote 
session protocol developed by Citrix Systems for 
communication between terminals and servers running 
Citrix WinFrame or Citrix MetaFrame.
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Internet The collection of networks and gateways that use the 
TCP/IP protocol family and function as a single, 
cooperative virtual network that connects many 
businesses, universities, and government facilities.

LAN Local Area Network. A network that connects devices 
over relatively short distances, typically within a 
building or campus.

MetaFrame Server software from Citrix Systems that provides 
connectivity for NCD ThinSTAR terminals through the 
ICA protocol.

Microsoft Terminal Server 
Client

An implementation of Microsoft’s RDP remote session 
protocol. It enables terminals and Terminal Servers to 
exchange graphical application input and output. See 
also client and Terminal Server.

Microsoft Windows CE A compact Microsoft operating system, originally 
developed for handheld devices, that has been adapted 
for use in thin client devices. See also thin client.

NCD ThinSTAR NCD Windows-based terminal.

name server A host that provides translation between network 
hostnames and IP addresses. See also DNS.

NCD ThinSTAR boot 
software

Low-level code that initiates the startup process of an 
NCD ThinSTAR terminal when it is powered up or 
restarted.

NCD ThinSTAR 
Management Service 
(TMS)

An NCD utility that runs on a Windows  server. Can be 
configured to automatically replace outdated or 
corrupt Operating Software on terminals.
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NetBIOS A communication protocol developed for networks of 
Microsoft platforms. NetBIOS identifies devices by the 
ID number of their NICs (Network Interface Cards). A 
device’s hostname is mapped to its NIC IDs.

The WINS name resolution service can map NetBIOS 
hostnames to IP addresses so that Microsoft platforms 
can communicate over TCP/IP networks.

network server See Windows  server.

PPP Point-to-Point Protocol. The NCD dial-up client uses 
this protocol to establish a connection with a network 
server over a modem.

PPPD Point-to-Point Protocol Daemon. A service that the PPP 
client communicates with.

Primary Domain 
Controller

See domain controller.

published application An application configured by the system administrator 
for remote users. With published applications, the user 
accesses only the specified application and does not 
need to know the address of a specific server to create a 
connection.

RAS Remote Access Service. A service on Windows hosts 
that enables users to dial into a Windows network with 
a modem.

RDP Remote Desktop Protocol, a proprietary 
communication protocol that Microsoft Corporation 
developed so that Windows-based Terminals, such as 
the NCD ThinSTAR terminal, could communicate with 
Terminal Servers.
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SNMP agent Software on a terminal that reports terminal settings to 
the SNMP manager (if it is installed). The SNMP agent 
is read-only by default. The full list of SNMP values is 
in the NCD-THINSTAR.MIB.txt file, which is installed 
by default in 
\Program Files\NCD\ThinSTAR Management.

You need the NCD ThinPATH Manager Configuration 
Tool to enable SNMP to write and change terminal 
settings.

subnet A physical network within a larger IP network. Allows 
a site to use a single Internet network for multiple 
physical networks.

subnet mask The format of an IP address that shows which part of 
the address identifies the subnet and which part 
identifies a particular machine.

TCP/IP Transmission Control Protocol/Internet Protocol. A 
common name for the Internet protocol family.

terminal A set of input and output devices, such as a monitor 
and keyboard, that access data and/or computing 
services on a server across a network.

Terminal Server A server running the Microsoft Windows NT Server 
4.0, Terminal Server Edition operating system. It allows 
Windows-based terminals like the NCD ThinSTARs to 
run Windows  applications remotely.

Terminal Server host A computer running the Microsoft 2000 operating 
system or the Microsoft Windows NT Server 4.0, 
Terminal Server Edition operating system. See also 
Terminal Server.

thin client Terminal software that manages input and output 
between a user’s input/output devices (keyboard, 
mouse, and monitor) and a server using a remote 
session protocol. See thin client device.
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thin client device Hardware that runs thin client software. See thin client.

ThinSTAR See NCD ThinSTAR.

TMS See NCD ThinSTAR Management Service (TMS).
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A
About tab 68
address 9

gateway 8
IP 9
mode 32
static 9
static IP 32

application
published 77
startup 73

audio configuration 43
Audio tab 43
auto-locate broadcast 77
autostart connection

setting 113
stopping 116

B
Best Available Using 

DDC 9, 27, 30

C
Change Password tab 38, 

39
Citrix

ICA client/connection
adding connection 76
client name 85
colors 85

global settings 83
hotkeys 84
logging off 90
palette device 85
primary Citrix 

server 77
printing 90
published 

application 77
server locations 86
starting 88
stopping 90
wizard 76

Citrix ICA client 11
Citrix ICA connection 11
Citrix MetaFrame 5
Citrix WinFrame 

operating system 5
client 126

Citrix ICA 11
default 7, 12
Microsoft Terminal 

Server 11
NCD dial-up 11
selecting in Connection 

Manager 109
client default 54
Clients tab 53
communication 

session 119

configuration
keyboard 29

Configure tab 12, 28
enabling 54

connection
adding in Connection 

Manager 108
autostart

setting 113
stopping 116

Citrix ICA
See Citrix ICA client/

connection.
default 112
deleting in Connection 

Manager 110
diagnostics 51
editing in Connection 

Manager 109
hotkeys 48
low speed 72
RDP

See RDP connection.
serial 72
stopping

autostart 
connection 116

in Connection 
Manager 112

type 49

Index



130 NCD ThinSTAR Terminal User’s Guide

wizard
Citrix ICA 76
RDP 71

Connection Manager 12, 
119
adding connection 108
autostart connection

setting 113
stopping 116

Configure tab 28
enabling 54

default connection 112
deleting 

connection 110
displaying 108
stopping 

connection 111
connection(s)

Citrix ICA 11
creating 11
LAN 11
modem 11
NCD dial-up 11
RDP 11

Create Password tab 36

D
DDC compliant 

monitors 9
default(s)

client 7, 12, 53
connection 112
domain name 9
factory, list of 25
factory, resetting 25
Terminal Properties 

access 39

delete 110
deleting connection 110
device name resolution 9
DHCP 27, 33, 34

enabling or 
disabling 32

timeout 28, 50
DHCP addressing 7
diagnostics 13
diagnostics, 

connection 51
dial-up

client 125
disconnect 119
disconnecting

RDP connection 76
display

modifying 30
refresh frequency 30

display refresh rate 9
Display tab 28, 30
DNS 34

name resolution 
service 8

server 9
documentation

ThinPATH Manager 2
ThinSTAR operating 

system 2
domain name, default 9
domain,

Windows 72

E
Energy Star compliant 

monitor 53
Enter Password tab 36

Extensions tab 54

F
factory defaults

listed 26, 27
resetting 25

firewall 82, 87

G
gateway 34
gateway, specifying 8
global ICA settings 83
Graphics tab 67
group, renaming 87

H
Hardware tab 62
hardware version 61
HighColor 27, 31, 80, 85
host name

mapped to IP 
address 34

hotkeys 19
connection 48

hotkeys for Citrix ICA 84
Hotkeys tab 48

I
IE Browser 56, 107, 111, 

113, 115
options 57

Input tab 29
installed software 63
Inventory tab 61
IP address 9, 28, 34

mapped to host 
name 34
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K
key repeat 29

L
LAN

connection 49
mode 49

LAN connection 11
language 54
locale, Windows 

Terminal Server 54
log off 119

Citrix ICA 
connection 90

RDP connection 76
low speed connection 72

M
Management Server

assigning 20
specifying 47
timeout 50

microphone 28, 43
Microsoft Terminal 

Server client 11
Microsoft Windows 

2000 5
Microsoft Windows NT 

4.0, Terminal Server 
Edition 5

modem 125
callback 97
connection

See NCD dial-up 
connection or ICA 
dial-in 
connection.

modem connections 11

monitor 9
Energy Star 

compliant 53
power 52

mouse
button actions 29
configuration 29, 42

mute speaker 43

N
name resolution 

service 8, 9, 32
choosing 33
DNS 34
enabling 34
WINS 33, 34

NCD dial-up
client 99
connection

adding 98
starting 105
startup 104
stopping 106

NCD dial-up client 11
NCD dial-up 

connection 49
selecting 49

NCD ThinSTAR
Terminal 

Properties 119
network

connection timeouts 50
connection type 49
speed 49
wireless 55

network services
name resolution 32

WINS 33
Network tab 28, 31, 49

P
ping command 50, 51
pointer speed 42
Pointer tab 42
power 28

monitor 52
screen saver 30
timeouts 53

Power tab 52
Powerdown Timeout 53
PPP service 72
primary server for name 

resolution 9
printing locally during 

ICA sessions 90
published application 77

R
RDP connection 11

adding 71
disconnecting 76
logging off 76
protocol 71
starting 74
stopping 76

refresh rate 9
rename groups 87
reset to defaults 25
resolution 30

S
screen

resolution 30
saver 27, 30, 31
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secondary server for 
name resolution 9

serial connection 72
server

group 78, 86
locations 86
name resolution 9
primary Citrix 77
SOCKS proxy 82

Server tab 47
session

ending 119
setup wizard 26
SOCKS proxy server 82
software installed 63
Software tab 63
speaker

mute 43
volume 43

static IP address 33
subnet mask 8, 34
Suspend Timeout 53

T
TCP/IP domain 9
terminal 126

identification 56
Terminal Properties

access 19
address 

configuration 31
cancelling changes 20
connection hotkeys 48
displaying 19
exiting 20
field and tab access 39

keyboard
configuration 29

mouse 
configuration 29

name resolution 
service, enabling 34

network connection 49
password 19, 35
resetting factory 

defaults 25
saving changes 20
security 35
tabs

Display tab 30
Extensions 54
Input tab 29
Inventory tab 61

About 68
Graphics 67
Hardware 62
Software 63

Management tab
Audio 43
Clients 53
Hotkeys 48
Network 49
Pointer 42
Power 52
Server 47

Network tab 31
Security tab

Change 
Password 38, 39

Create 
Password 35, 36

Enter Password 36
thin client 126

device 126, 127
timeout

DHCP 28, 50
Management Server 50
powerdown 53
suspend 53

V
version, hardware 61
volume

mute 43
speakers 43
testing 43

W
web connection 110
Windows domain

for RDP connection 72
Windows RAS/TAPI 

subsystem 99
Windows Terminal 

Server 71
locale 54

WINS 8, 33, 34
wireless network 55
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